TABLE OF CONTENTS

Orders with Requisitions .................................................................................................................... 4
  Order by Patient’s Name (Specimens from Non-interfaced Sites) .................................................. 4
  Order Entry by Medical Record Number (Specimens from Non-interfaced Sites) ..................... 9
  Bridgepoint Hospital Order Entry ................................................................................................. 14
  Toronto Grace Hospital Order Entry ............................................................................................. 20
  Add New Specimen to Previous Patient (Specimens from Non-Interfaced Sites) ...................... 25
  Adding A New Doctor Not in System (Specimens from Non-Interfaced Sites) ......................... 27
Orders with HIS Specimen Numbers .................................................................................................. 31
  Accessioning Specimens with EPR Label Using Shortcuts .......................................................... 31
  Accessioning Specimens with EPR Label ....................................................................................... 33
  Accessioning Specimens from Rouge Valley Health Services ..................................................... 35
  Blood culture from Rouge Valley Health System ......................................................................... 38
  Accessioning Fluids Received in Bacti-Alert Bottles (with EPR Label, NOT PD Effluent Dialysate and Bone Marrow) ................................................................. 41
  Accessioning Specimens with EPR Label Using Shortcuts .......................................................... 44
  Receiving Bacteriology Specimens Entered in a HIS (Hospital Information System) at Point of Collection ........................................................................................................ 46
  Receiving Bacteriology Specimens Collected on the 4th Floor Specimen Collection Center ........ 48
  Receiving Serology Specimens Collected on the 4th Floor Specimen Collection Center ............. 50
Editing Orders ....................................................................................................................................... 52
  Editing an Order (Specimens from Non-Interfaced Sites) ............................................................ 52
  Add Additional Media to a New Specimen Ordered on a Previous Patient (Specimens from Non-Interfaced Sites) .......................................................... 54
  Cancel an Order (Specimens from Non-Interfaced Sites) .............................................................. 56
Printing PHL Send Out Forms .............................................................................................................. 58
Results Entry ....................................................................................................................................... 59
  Result Entry One Order .................................................................................................................. 59
    Searching for a Patient in Result Entry .......................................................................................... 59
    Entering Isolate Information in Result Entry ................................................................................. 59
    Generating Drugs ......................................................................................................................... 60
    Adding Media in Result Entry ...................................................................................................... 60
    Drug Manipulation ........................................................................................................................ 61
    Adding a Drug ............................................................................................................................... 61
    Cancelling a Drug .......................................................................................................................... 61
    Deleting a Drug ............................................................................................................................. 61
Unsuppressing a Drug .................................................. 61
Isolate Suppression ...................................................... 62
Batch Resulting .............................................................. 63
MRSA Bench ................................................................. 63
Use of Macro ................................................................. 74
Autoresulting ................................................................. 80
Resulting Worklist – Printing Labels .................................. 81
Batch Resulting TB Old Worklist ....................................... 82
To Fax Instant Report – Result Entry - Micro ......................... 88

Other Softmic Functions .................................................... 89
Starting/Stopping Interface ............................................... 89
Manual Downloading –Vitek .............................................. 90

SoftMic QC Entry ............................................................ 91

SoftLab .......................................................... 94
LIS Serology- Introduction ............................................... 94
Test Codes ............................................................... 94
Instrument-Interfaced Tests ............................................... 94
Basic Lab Query ............................................................ 96
Bridging from Order Entry-Lab Query .................................. 97
Bridging from Result Entry-Lab Query .................................. 98
Fields and Buttons- Lab Query ............................................. 99
Building Tasklist ............................................................ 103
Editing Tasklist ............................................................. 104
Reprinting Tasklist .......................................................... 105
Fields And Buttons Descriptions -Tasklist .............................. 106
Result Entry – One Order Number ........................................ 110
Result Entry - Batch Resulting (Tasklist) ................................ 111
Verifying Result – One Order .............................................. 113
Verifying Result – Tasklist ................................................. 114
Fields and Buttons Descriptions – Result Window .................... 115
Fields and Buttons Descriptions - Tasklist ................................ 121
Fields and Buttons Descriptions - Result Search Window ............. 125
Fields and Buttons - Interface ............................................. 126
Starting/Stopping Interface ............................................... 132
Toolbars - Interface ....................................................... 142
Printing Report( Results Report) .......................................... 142
To Fax Instant Report – Order Entry ..................................... 146
Entering New Control Lot Number ...................................... 147
QC Entry .......................................................... 148
Pending List Review for Architect and 8SERO Tests.......................................................... 149
Send Out Workflow ........................................................................................................ 150
Printing PHL Serology and HIV Forms ........................................................................... 155
Printing PHL Forms for TB and Parasitology and Other Sendout ......................... 156
Faster Way to Enter and Verify PHL Results ................................................................. 158
Reporting SoftMIC results though Call List ................................................................. 162
Documenting A Call ......................................................................................................... 162
SoftStore .......................................................................................................................... 164
  Logging On Procedure to SoftLabMicStore ................................................................. 164
Add a New Specimen Vial to the Freezer .................................................................... 165
Add a New Isolate Vial to the Freezer .......................................................................... 167
Reprint Labels .................................................................................................................. 169
Orders with Requisitions

Order by Patient’s Name (Specimens from Non-interfaced Sites)

To place an order into the system starting at Patient’s name, receive the specimen, and generate barcode labels for the specimen.

<table>
<thead>
<tr>
<th>KEYSTROKE</th>
<th>INSTRUCTIONS/RESULTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log into the system</td>
<td>Order Entry Search Screen displays, cursor defaults to the Billing field</td>
</tr>
<tr>
<td>1. Double Click on the Order Entry Icon</td>
<td></td>
</tr>
<tr>
<td>2. Click on the Last Name field</td>
<td>Type Last Name</td>
</tr>
<tr>
<td>3. Click on Next button</td>
<td>Search patient by Last Name</td>
</tr>
<tr>
<td></td>
<td>If the name entered is not in the system, a window displays, click on Yes button to</td>
</tr>
<tr>
<td></td>
<td>create new patient. Cursor defaults to Last Name field.</td>
</tr>
<tr>
<td></td>
<td>If a similar name(s) exists in the system, a list will display on a window, look for</td>
</tr>
<tr>
<td></td>
<td>a match. If there is no match, click on New button then click on New Patient. Cursor</td>
</tr>
<tr>
<td></td>
<td>defaults to Last Name field.</td>
</tr>
<tr>
<td>4. First</td>
<td>Type in First name</td>
</tr>
<tr>
<td>5. Middle</td>
<td>Type in Middle name</td>
</tr>
<tr>
<td>6. DOB</td>
<td>Click on the drop down button to display calendar. Click on the calendar to enter date</td>
</tr>
<tr>
<td></td>
<td>of birth using YYYY/MM/DD format. If you enter a date of birth, the system</td>
</tr>
<tr>
<td></td>
<td>automatically calculates the age in the Age</td>
</tr>
</tbody>
</table>
field. If the date of birth is unknown, you may click on the Age field and enter an age.

7. MRN

Enter Medical Record Number. See MRN FORMAT page for list of code format for clients.

8. Sex

Click on drop down button to display list Click on appropriate Sex or type f for female, m for male, u for unknown, n for not known

9. Patient Comm

Enter patient comments

10. HCN

Enter Health Card Number

11. ESO

Entered by ICP when appropriate


Click on the dropdown button to display list Click on appropriate Species or type h for Homo Sapiens, o for Other Species

In the Stay Section- Under the General Tab:

13. Att. Dr.

Click on drop down button to display Doctor Search Screen window. Enter available information (Doctor’s ID, Last Name and First Name) then click Find to search. You can also search by scrolling down the list and double clicking on the corresponding #.

14. Billing

Automatically generated

15. Adm On

Current default date

16. By:

Press Tab to get to the next field
17. **Stay Comm**

    Click to enter Stay Comments or press Tab to get to the next field.

18. **Ward/Hospital Name**

    Click on drop down button to display **Clinic Search Screen** window. You can search by scrolling down the list and double clicking on the corresponding #, or by moving the cursor to **Area** to search by Hospital eg. MSH, QEU, QED, CAMH, etc. Type hospital initial then click on **Find**. List of Clinics under Area entered displays. Scroll down the list to find clinic of choice. Double Click on the corresponding # to enter Ward.

19. **Room**

    Enter information if available

20. **Bed**

    Enter information if available

21. **Report to**

    Click on drop down button to display **Doctor Search Screen** window. Enter available information (Doctor’s ID, Last Name and First Name) then click **Find** to search. You can also search by scrolling down the list and double clicking on the corresponding #.

22. **Req. by**

    Press Tab to assume that the requesting physician is the attending physician

23. **Call**

    Click on Call button to enter Call back information.

24. **Order Comm**

    Click on Order Comm button to enter order comments

25. **Priority**

    Click on drop down button to display list or type **r** for **Routine Order**, **s** for **Stat**
26. **Tab or Enter 6x**

To get to the **ID field** on the **Test Ordered Section** or you can simply click on it. The main **Order Entry Keypad** window will display.

Follow Order/Entry Table for selection of TESTS to be ordered. The following is an example:

**How to order a Sputum Culture and Sensitivity with TB culture:**

27. **J**

Sputum C&S

28. **M**

Click on M to go to TB Tests|>TBTST

29. **A**

Click on A to order TB as additional test

30. **Source**

Click on drop down button to display list. Click on appropriate Source or choose # from keypad

31. **Site**

Click on Expectorated or Suctioned or choose # from keypad

32. **Click on Add/F6 button x2**

To document **Collected, Received time and date**

33. **Current antibiotic therapy**

Click on drop down button to display **Search Results** window. Scroll down the list to find antibiotic of choice, double click on it or type # then press Enter. Drop down button beside antibiotic listed is highlighted, click on it to list another drug

34. **Save**

Click on **SAVE icon** or **Control S** to save the order or Click on **Add next order icon** to add another order on the same patient.

35. **Click Yes**

To answer the question **“Do you want to save the changes you made to order?”**
36. **Choose label printer**

   Click **OK** to print **Collection Label** (for all collected specimens)

37. **Order Entry Search Screen** displays, cursor defaults to the **Billing** field

   If **adding next order on the same patient**, **Main Order Entry Screen** displays, cursor defaults to **Req. by** field
Order Entry by Medical Record Number (Specimens from Non-interfaced Sites)

To place an order into the system, receive the specimen, and generate barcode labels for the specimen.

**KEYSTROKES**

Log into the system

1. Double Click on the **Order Entry Icon**
2. Click on the **MRN** field
3. Click on **Next** button or press **Enter**

**INSTRUCTIONS/RESULTS**

Order Entry Search Screen displays, cursor defaults to the **Billing** field

Type in Medical Record Number. See MRN FORMAT page for list of code format for clients.

Search patient by MRN.
List of MRN displays, choose correct MRN

If the patient has been entered into the system previously, a window with the patient’s Case/Billing number(s) will display:

a. Choose the case/billing number that matches the case/billing number on the requisition. Click on **Finish** or press **Enter**
   (See Appendix CASE NUMBERS for proper case/billing # selection).

b. Check patient’s demographics:
   If all correct, click **Finish** button then **proceed to step 22.**
   If the patient information does not match requisition, let one of the LIS Officer know so that they can fix it.

If the patient is not yet entered into the system, a window displays, click on **Yes** button to create new patient. Cursor defaults to Last Name field.

In the patient demographics section: **Fields in yellow are Required Information. TAB key moves cursor to the next field.**
4. Last Name  
Type in Last name

5. First  
Type in First name

6. Middle  
Type in Middle name

7. DOB  
Click on the drop down button to display calendar. Click on the calendar to enter date of birth using YYYY/MM/DD format. If you enter a date of birth, the system automatically calculates the age in the Age field. If the date of birth is unknown, you may click on the Age field and enter an age.

8. Sex  
Click on drop down button to display list
Click on appropriate Sex or type f for female, m for male, u for unknown, n for not known

9. Patient Comm  
Enter patient comments

10. HCN  
Enter Health Card Number

11. ESO  
Entered by ICP when appropriate

Click on the dropdown button to display list
Click on appropriate Species or type h for Homo Sapiens, o for Other Species

In the Stay Section- Under the General Tab:

13. Att. Dr.  
Click on drop down button to display Doctor Search Screen window. Enter available information (Doctor’s ID, Last Name and First Name) then click Find to
14. **Billing**

   Automatically generated

15. **Adm On**

   Current default date

16. **By:**

   Press Tab to get to the next field

17. **Stay Comm**

   Click to enter Stay Comments or press Tab to get to the next field

18. **Ward/Hospital Name**

   Click on drop down button to display **Clinic Search Screen** window. You can search by scrolling down the list and double clicking on the corresponding #, or by moving the cursor to **Area** to search by Hospital eg. MSH, QEU, QED, CAMH, etc. Type hospital initial then click on **Find**. List of Clinics under Area entered displays. Scroll down the list to find clinic of choice. Double Click on the corresponding # to enter Ward.

19. **Room**

   Enter information if available

20. **Bed**

   Enter information if available

**In the Order Section:**

21. **Report to**

   Click on drop down button to display **Doctor Search Screen** window. Enter available information (Doctor’s ID, Last Name and First Name) then click **Find** to search. You can also search by scrolling...
down the list and double clicking on the corresponding #.

22. **Req. by**

Press Tab to assume that the requesting physician is the attending physician.

23. **Call**

Click on Call button to enter Call back information.

24. **Order Comm**

Click on Order Comm button to enter order comments

25. **Priority**

Click on drop down button to display list or type r for **Routine Order**, s for **Stat**

26. **Tab or Enter 6x**

To get to the **ID field** on the **Test Ordered Section** or you can simply click on it. The main **Order Entry Keypad** window will display.

Follow Order/Entry Table for selection of TESTS to be ordered. The following is an example:

How to order a Sputum Culture and Sensitivity:

27. **J**

Sputum C&S

28. **Source**

Click on drop down button to display list. Click on appropriate Source or choose # from keypad

29. **Site**

Click on Expectorated or Suctioned or choose # from keypad

30. **Click on Add/F6 button x2**

To document **Collected, Received time and date**

31. **Save**

Click on **SAVE icon** or **Control S** to save the order or Click on **Add next order icon** to add another order on the same patient.
32. **Click Yes or type Y** To answer the question “Do you want to save the changes you made to order?

33. **Choose label printer** Click OK to print Collection Label (for all collected specimens)

34. **Order Entry Search Screen** displays, cursor defaults to the **Billing** field

   If **adding next order on the same patient**, **Main Order Entry Screen** displays, cursor defaults to **Req. by** field
Bridgepoint Hospital Order Entry

KEYSTROKES

Log into the system

1. Double Click on the Order Entry Icon

Order Entry Search Screen displays, cursor defaults to the Billing field

2. MRN

(HI############)

NAME  SMITH, JOHN  99-0000054
100 JAMESON AVENUE TORONTO, ON
DOB  DOB 08/04/1964 CH 33137 MRN
100 JAMESON AVENUE TORONTO, ON
MOUNT SINAI HOSPITAL 534-1870
Clinic/Ward/Room  35754  503  36 M S CAT
SMITH, JOHN  522-5037
HCN  HN 9656673395

3. Click on Next button or press Enter

Search patient by MRN.
List of MRN displays, choose correct MRN

If the patient has been entered into the system previously, a window with the patient’s Case/Billing number(s) will display:

   c. Choose the case/billing number that matches the case/billing number on the requisition. Click on Finish or press Enter

      (See Appendix CASE NUMBERS for proper case/billing # selection).

   d. Check patient’s demographics:

      If all correct, click Finish button then proceed to step .

      If the patient information does not match requisition, let one of the LIS Officer know so that they can fix it.

If the patient is not yet entered into the system, a window displays, click on Yes button to create new patient. Cursor defaults to Last Name field.

In the patient demographics section: Fields in yellow are Required Information. TAB key moves cursor to the next field.
4. Last Name
Type in Last name

5. First
Type in First name

6. Middle
Type in Middle name (can be bypassed if not available)

7. DOB
Click on the drop down button to display calendar. Click on the calendar to enter date of birth using YYYY/MM/DD format. If you enter a date of birth, the system automatically calculates the age in the Age field. If the date of birth is unknown, you may click on the Age field and enter an age.

8. Sex
Click on drop down button to display list
Click on appropriate Sex or type f for female, m for male, u for unknown, n for not known

9. Patient Comm
Enter patient comments

10. HCN
Enter Health Card Number

11. ESO
Entered by ICP when appropriate

Click on the dropdown button to display list
Click on appropriate Species or type h for Homo Sapiens, o for Other Species

In the Stay Section - Under the General Tab:

13. Att. Dr.
Click on drop down button to display Doctor Search Screen window. Enter available information (Doctor's ID, Last Name and First Name) then click Find to search. You can also search by scrolling.
down the list and double clicking on the corresponding #.

If there is no matching doctor:

**General browser: Record not found!**

window displays. Click **OK** then click **Cancel** to get back to the main order entry screen.

If the particular doctor is not on the list:

Click **Cancel** to get back to the main order entry screen.

14. **Press ***

**Auxillary Doctor Screen** displays

15. **Doctor’s Information**

Enter as much information as available on the requisition in appropriate fields. (Ensure you have entered some phone number)

If no doctor’s name given:

Type **NODOC** (Code for unknown doctor on the **Att. Dr.**)

16. Click **OK**

When you have completed entering the Doctor’s information.

14. **Billing**

 Automatically generated

15. **Adm On**

Current default date

16. **By:**

Press Tab to get to the next field

17. **Stay Comm**

Click to enter Stay Comments or press Tab to get to the next field

18. **Ward/Hospital Name**

Click on drop down button to display **Clinic Search Screen** window. Move the cursor to **Area** to search by Hospital.
Type RH then click Find. List of Clinics under Area entered displays. Scroll down the list to find clinic of choice. Double Click on the corresponding # to enter Ward.

19. **Room**
   Enter information if available
   Room – 518, 307

20. **Bed**
   Enter information if available
   Bed – A, B, 1, 2

21. **Diagnosis**
   Click on drop down button to display Search Results window. Enter available information then click Find to search. You can also search by scrolling down the list and double clicking on the corresponding #.

22. **Req. by**
   Press Tab to assume that the requesting physician is the attending physician

23. **Priority**
   Click on drop down button to display list or type r for Routine Order, s for Stat

24. **Tab 5x**
   Press Tab five times to get to the ID field on the Test Ordered Section or you can simply click on it. The main Order Entry Keypad window will display. It automatically defaults to the screen of the clinic you selected.

25. **Order test/s**
26. **Source**
   Click on drop down button to display list. Click on appropriate Source or choose # from keypad

27. **Site**
   Choose from keypad (upper right hand corner) or free-text. This is where you are going to put any O/E Comment.
28. **Click on Add/F6 button x2**

   To document **Collected date and time** (copy from requisition, if not available or if only date is given click Add/F6 to enter current date and time), **and Received time and date**

29. **Current antibiotic therapy**

   Click on drop down button to display **Search Results** window. Scroll down the list to find antibiotic of choice, double click on it or type # then press Enter. Drop down button beside antibiotic listed is highlighted, click on it to list another drug.

30. **Micro OE Comment**

   Enter additional comments/instructions if you have any.

31. **Media button**

   **Media Screen** window displays.

32. Click on a blank field on the test line

33. **Add Media**

   **Search result** window displays list. Double click on media you want to add or choose # from keypad then click OK.

34. **Cancel selected media**

   Click on the media you want to cancel then click this button. Click OK to close Media screen and save changes made.

35. **Save**

   Click on **SAVE icon** or **Control S** to save the order or Click on **Add next order icon** to add another order on the same patient.

36. Click **Yes** or type **Y**

   To answer the question **“Do you want to save the changes you made to order?”**
37. **Choose label printer**

Click **OK** to print **Collection Label (for all collected specimens)**

38. **Order Entry Search Screen** displays, cursor defaults to the **Billing** field

If **adding next order on the same patient**, **Main Order Entry Screen** displays, cursor defaults to **Req. by** field
Toronto Grace Hospital Order Entry

KEYSTROKES

Log into the system

1. Double Click on the Order Entry Icon

Order Entry Search Screen displays, cursor defaults to the Billing field

2. MRN

Enter Medical Record Number
CHART # G + 6 digits
e.g. G000209/G000204/G010204

NAME ➔ SMITH, JOHN

GC000089/11 27/07/118 1025

DOCTOR’S NAME ➔ DR. SMART, SYDNEY

HCN ➔ 8562 460 198 - FL

DOB ➔ 19/07/1929 416-633-5587

2705-209 WYNFORD DRIVE

TORONTO M3C 3P4

MRN ➔ CHART# G010528 GCHR4 ➔ WARD

TORONTO GRACE 416-925-2251

3. Click on Next button or press Enter

Search patient by MRN.
List of MRN displays, choose correct MRN

If the patient has been entered into the system previously, a window with the patient’s Case/Billing number(s) will display:

e. Check patient’s demographics:
If all correct, click Finish button then proceed to step .
If the patient information does not match requisition, let one of the LIS Officer know so that they can fix it.
If the patient is not yet entered into the system, a window displays, click on Yes button to create new patient. Cursor defaults to Last Name field.

In the patient demographics section: Fields in yellow are Required Information. TAB key moves cursor to the next field.

4. Last Name Type in Last name
5. First Type in First name
6. Middle Type in Middle name (can be bypassed if not available)
7. DOB Type in Date of birth by selecting from the calendar.

If the patient is not yet entered into the system, a window displays, click on Yes button to create new patient. Cursor defaults to Last Name field.

In the patient demographics section: Fields in yellow are Required Information. TAB key moves cursor to the next field.

4. Last Name Type in Last name
5. First Type in First name
6. Middle Type in Middle name (can be bypassed if not available)
7. DOB Click on the drop down button to display calendar. Click on the calendar to enter date of birth using YYYY/MM/DD format. If you enter a date of birth, the system automatically calculates the age in the Age field. If the date of birth is unknown, you may click on the Age field and enter an age.
8. Sex Click on drop down button to display list Click on appropriate Sex or type f for female, m for male, u for unknown, n for not known
9. Patient Comm Enter patient comments
10. HCN Enter Health Card Number
11. ESO Entered by ICP when appropriate
12. Sp. Click on the dropdown button to display list Click on appropriate Species or type h for Homo Sapiens, o for Other Species

In the Stay Section- Under the General Tab:

13. Att. Dr. Type in SOFT Doctor Code (Doctor’s name found below the patients GC#)

15. Adm On: Current default date

16. By: Press Tab to get to the next field

17. Stay Comm: Click to enter Stay Comments or press Tab to get to the next field

18. Ward/Hospital Name: Type in **SOFT Location Codes**
   Note: Clinic usually starts with **CH** (eg. CH5, CH4) and is seen on the same line as the MRN. If not indicated check **Location for Report** on the requisition.
   - **GRU3** – Nursing Unit 3 (CH3/3rd floor)
   - **GRU4** – Nursing Unit 4 (CH4/4th floor)
   - **GRU5** – Nursing Unit 5 (CH5/5th floor)
   - **GRU6** – Nursing Unit 6 (CH6/6th floor)

19. Room: Enter information if available
   Room – 518, 307

20. Bed: Enter information if available
   Bed – A, B, 1, 2

21. Diagnosis: Click on drop down button to display **Search Results** window. Enter available information then click **Find** to search. You
22. **Req. by**

Press Tab to assume that the requesting physician is the attending physician.

23. **Priority**

Click on drop down button to display list or type **r** for Routine Order, **s** for Stat

24. **Tab or Enter 6x**

To get to the ID field on the Test Ordered Section or you can simply click on it. The main Order Entry Keypad window will display. It automatically defaults to the screen of the clinic you selected.

25. **Order test/s**

26. **Source**

Click on drop down button to display list. Click on appropriate Source or choose # from keypad.

27. **Site**

Choose from keypad (upper right hand corner) or free-text. This is where you are going to put any O/E Comment.

Eg. O2 and ANO2 swab rec’d
    Rec’d in starplex container
    O2 swab rec’d

28. **Click on Add/F6 button x2**

To document Collected, Received time and date.

29. **Current antibiotic therapy**

Click on drop down button to display Search Results window. Scroll down the list to find antibiotic of choice, double click on it or type # then press Enter. Drop down button beside antibiotic listed is highlighted, click on it to list another drug.

30. **Micro OE Comment**

Enter additional comments/instructions if you have any.

can also search by scrolling down the list and double clicking on the corresponding #.
### Section: Bacteriology Procedures

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>31.</td>
<td><strong>Media</strong> button</td>
</tr>
<tr>
<td>32.</td>
<td>Click on a blank field on the test line</td>
</tr>
<tr>
<td>33.</td>
<td><strong>Add Media</strong></td>
</tr>
<tr>
<td>34.</td>
<td><strong>Cancel selected media</strong></td>
</tr>
<tr>
<td>35.</td>
<td><strong>Save</strong></td>
</tr>
<tr>
<td>36.</td>
<td>Click <strong>Yes</strong> or type <strong>Y</strong></td>
</tr>
<tr>
<td>37.</td>
<td><strong>Choose label printer</strong></td>
</tr>
<tr>
<td>38.</td>
<td><strong>Order Entry Search Screen</strong> displays, cursor defaults to the <strong>Billing</strong> field</td>
</tr>
</tbody>
</table>

If **adding next order on the same patient**, **Main Order Entry Screen** displays, cursor defaults to **Req. by** field
Add New Specimen to Previous Patient (Specimens from Non-Interfaced Sites)

Add a new order to a patient in the system.

Example: Add bite swab on the left hand to a previous patient.

**KEYSTROKES**

1. Double Click on the **Order Entry Icon**
2. Click on the **MRN** or **LastName** field
3. Click **Next** button or press **Enter** to search
4. Click **Next** button or press **Enter**
5. Click **Finish**
6. **Tab** or **Enter 9x**

**INSTRUCTIONS/RESULTS**

Order Entry Search Screen displays, cursor defaults to the **Billing** field.

Type in **MRN** or patient’s full or partial name.

A search window will display with one or more patients with their **MRN**. Select the correct patient.

A window will now display with your patient’s **MRN**, **Name**, **Ward** and various stays for your patient. Select the current stay (match the encounter # from the requisition).

If a specimen on that patient has been ordered, a list of previous lab orders will display. If this is a new specimen of the day for this patient click **New** button then choose **New Order**.

To create a new order. **Order Entry Screen** displays. Cursor is defaulted to **Req. by** field.

To get to the **ID field** on the **Test Ordered Section** or you can simply click on it. The
From the Order Entry Keypad:

7. Click on PMH/TTH|>OETML

8. F Misc C&S|>TTHCS

9. A Culture and Sensitivity

10. Source Click on drop down button to display list. Double click on appropriate Source or choose # from keypad then click OK

11. Site Free text: Left Hand

12. Click on Add/F6 button 2x To document Collected, Received time and date

13. Save Click on SAVE icon or Control S to save the order or Click on Add next order icon to add another order on the same patient.

14. Click Yes or type Y To answer the question “Do you want to save the changes you made to order?”

15. Choose label printer Click OK to print Collection Label (for all collected specimens)

16. Order Entry Search Screen displays, cursor defaults to the Billing field

If adding next order on the same patient, Main Order Entry Screen displays, cursor defaults to Req. by field
Adding A New Doctor Not in System (Specimens from Non-Interfaced Sites)

Add a doctor not currently listed in the system.

Example: A new patient has been seen by Dr. Scully in her office. After careful examination, she draws a set of blood cultures into FAN aerobic and FAN anaerobic bottles on this patient. Her nurse brings the specimens and requisitions to the Microbiology for processing.

N.B. This patient has no previous history

**KEYSTROKES**

Log into the system

1. Double Click on the **Order Entry Icon**
   - **Order Entry Search Screen** displays, cursor defaults to the **Billing** field

2. Click on the **Last Name** field
   - Type Last Name

3. Click on **Next** button or press **Enter**
   - Search patient by Last Name
     - If the name entered is not in the system, a window displays, click on **Yes** button to create new patient. Cursor defaults to Last Name field.
     - If a similar name(s) exists in the system, a list will display on a window, look for a match. If there is no match, click on **New** button then click on **New Patient**. Cursor defaults to Last Name field.

4. **First**
   - Type in First name

5. **Middle**
   - Type in Middle name

6. **DOB**
   - Click on the drop down button to display calendar. Click on the calendar to enter date
of birth using YYYY/MM/DD format. If you enter a date of birth, the system automatically calculates the age in the Age field. If the date of birth is unknown, you may click on the Age field and enter an age.

7. MRN

Enter Medical Record Number. See MRN FORMAT page for list of code format for clients.

8. Sex

Click on drop down button to display list
Click on appropriate Sex or type f for female, m for male, u for unknown, n for not known

9. Patient Comm

Enter patient comments

10. HCN

Enter Health Card Number

11. ESO

Entered by ICP when appropriate


Click on the dropdown button to display list
Click on appropriate Species or type h for Homo Sapiens, o for Other Species

In the Stay Section- Under the General Tab:

13. Att. Dr.

Click on drop down button to display Doctor Search Screen window. Enter available information (Doctor’s ID, Last Name and First Name) then click Find to search. You can also search by scrolling down the list and double clicking on the corresponding #.

If there is no matching doctor:

General browser: Record not found! window displays. Click OK then click
14. **Press ***

Auxiliary Doctor Screen displays

15. **Doctor’s Information**

Enter as much information as available on the requisition in appropriate fields. (Ensure you have entered some phone number)

16. **Click OK**

When you have completed entering the Doctor’s information.

17. **Billing**

Automatically generated

18. **Adm On**

Current default date

19. **By:**

Press Tab to get to the next field

20. **Stay Comm**

Click to enter Stay Comments or press Tab to get to the next field

21. **Ward/Hospital Name**

Click on drop down button to display Clinic Search Screen window. You can search by scrolling down the list and double clicking on the corresponding #, or by moving the cursor to Area to search by Hospital eg. MSH, QEU, QED, CAMH, etc. Type hospital initial then click on Find. List of Clinics under Area entered displays. Scroll down the list to find clinic of choice. Double Click on the corresponding # to enter Ward.
22. **Req. by**

Press Tab to assume that the requesting physician is the attending physician.

23. **Tab 8x**

Press Tab eight times to get to the **ID field** on the **Test Ordered Section** or you can simply click on it. The main **Order Entry Keypad** window will display.

24. **H**

Blood Culture

25. **Source**

Click on drop down button to display list of blood culture bottle combinations. Click on appropriate Source or choose # from keypad.

26. **6**

For **BFAFN** (FAN aerobic (FA) and FAN anaerobic (FN) bottles

27. **Site**

Select **Not specified** from keypad

28. **Click on Add/F6 button x2**

To document **Collected, Received time and date**

29. **Save**

Click on **SAVE icon** or **Control S** to save the order or Click on **Add next order icon** to add another order on the same patient.

30. **Click Yes**

To answer the question **“Do you want to save the changes you made to order?”**

31. **Choose label printer**

Click **OK** to print **Collection Label (for all collected specimens)**

32. **Order Entry Search Screen** displays, cursor defaults to the **Billing** field

If **adding next order on the same patient**, **Main Order Entry Screen** displays, cursor defaults to **Req. by field**
Orders with HIS Specimen Numbers

Accessioning Specimens with EPR Label Using Shortcuts

**KEYSTROKES**

Log into the system

1. Double Click on the **Order Entry Icon**

   **Order Entry Search Screen** displays, cursor defaults to the **Billing** field. Ensure Open in Edit Mode box is checked.

<table>
<thead>
<tr>
<th>Search by Patient</th>
<th>Search by Stay</th>
<th>Search by Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name:</td>
<td>Billing:</td>
<td>Order:</td>
</tr>
<tr>
<td>First Name:</td>
<td>Ward:</td>
<td>Ord Date:</td>
</tr>
<tr>
<td>MRN:</td>
<td>At Dr:</td>
<td>Reg by:</td>
</tr>
<tr>
<td>HCN:</td>
<td></td>
<td>Aux Order:</td>
</tr>
<tr>
<td>Reg:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DOB:</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**INSTRUCTIONS/RESULTS**

- Log into the system
- Double Click on the **Order Entry Icon**
- **Order Entry Search Screen** displays, cursor defaults to the **Billing** field. Ensure Open in Edit Mode box is checked.
2. Click on **Aux. Order** field

   Scan **HDS bar code** or type in **HDS specimen number**

3. Press **Enter** or Click **Next**

   Search window displays with list of possible matches.

4. Arrow down/Press **Enter** on highlighted match

   Main Order Entry Screen appears

4. Click **Finish** or press **Enter**

   To open the order

5. Click on **Micro tab**

   To open the **SOURCE SCREEN**

   Ideally it should come in with the Date and Time Collected, if not, click Add/F6 2x to enter current date and time on Collected and Received Date and Time Received

   If specimen came with Collected date and time, click Add/F6 on Received date and time
Accessioning Specimens with EPR Label

KEYSTROKES

Log into the system

1. Double Click on the **Order Entry Icon**
2. Click on **Aux. Order** field
3. Click **Next** or press **Enter**
4. Click **Finish** or press **Enter**
5. Click on **Micro tab**
6. Click on **Media** button
7. **Save**
8. Click **Yes** or type **Y**

INSTRUCTIONS/RESULTS

**Order Entry Search Screen** displays, cursor defaults to the **Billing** field

Scan **HDS bar code** or type in **HDS specimen number**

Search window displays with the order information

To open the order

To open the **SOURCE SCREEN**

Ideally it should come in with the Date and Time Collected, if not, click Add/F6 2x to enter current date and time on Collected and Received Date and Time Received

If specimen came with Collected date and time, click Add/F6 on Received date and time

If you want to check media for modification (add or cancel)

Click on **SAVE icon** or **Control S** to save the order

To answer the question “**Do you want to save the changes you made to order?**"
9. Choose label printer

Click OK to print Collection Label (for all collected specimens)

10. Order Entry Search Screen displays, cursor defaults to the Billing field

11. ALWAYS check the print out before attaching SCC labels to specimen. This is where information from the EPR/HDS order will be downloaded

<table>
<thead>
<tr>
<th>SCC order #</th>
<th>85210504</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient's name</td>
<td>SMITH, JOHN</td>
</tr>
<tr>
<td>Diagnosis</td>
<td>HEPATITIS &quot;B&quot; - CIRRHOSIS - TX</td>
</tr>
<tr>
<td>HIS order #</td>
<td>12496421</td>
</tr>
</tbody>
</table>

(Order double check with specimen before attaching SCC labels)

| Order Comment | R/O VRE |

Attach SCC label to specimen. Continue with the next specimen.

Give specimens to planting hood.
Accessioning Specimens from Rouge Valley Health Services

Log into the system

1. Double Click on the Order Entry Icon

Order Entry Search Screen displays, cursor defaults to the Billing field

2. Click on Aux. Order field

Type in MEDITECH specimen number

3. Click Next

Search window displays with the order information

4. Click Finish

To open the order

5. Click Edit Mode icon

To edit the order

6. Click on Micro tab

To open the SOURCE SCREEN

Ideally it should come in with the Date and Time Collected, if not, click Add/F6 2x to enter current date and time on Collected and Received Date and Time Received

If specimen came with Collected date and time, click Add/F6 on Received date and time
7. **Micro OE Comment**

To check for any additional test/s request, comments/instructions (e.g. Fungus and TB on an abscess/pus aspirate). Phone the facility to add the order and get the new MEDITECH number that corresponds to the order added.

**NOTE:** Never add an order directly on SOFT for these two (2) facilities for the report will never file back to them. Always phone and ask them to do the add-on.

7. **Media button**

If you want to check media for modification (add or cancel)

8. **Save**

Click on SAVE icon or Control S to save the order or Click on Add next order icon to add another order on the same patient.

9. Click Yes or type Y

To answer the question “**Do you want to save the changes you made to order?**

10. **Choose label printer**

Click OK to print Collection Label (for all collected specimens)

11. **Order Entry Search Screen** displays, cursor defaults to the **Billing** field

12. **ALWAYS** check the print out before attaching SCC labels to specimen

   - this is where all the information from the MEDITECH order will be downloaded

   SCC order #
   Patient’s name
   HIS order # (double check with specimen before attaching SCC labels)

Order Comment:

   - Relevant Diagnosis
   - Current Antibiotics
   - Specimen Description
Attach SCC label to specimen. Continue with the next specimen.

Give specimens to planting hood.
Accessioning Positive Blood Cultures from Rouge Valley Health System

**Blood culture from Rouge Valley Health System**

Only positive blood cultures from Rouge Valley Health System (RVHS) are sent to this laboratory for culture identification and susceptibility testing. Blood culture bottles have been incubated in the BacT/Alert incubator at RVHS and have been flagged as positive. An initial Gram stain has been performed at RVHS and the ward has been notified. If the bottle was flagged positive after the normal carrier hours, a set of media plates would have to be sub cultured, incubated and sent along with the bottle.

The gram stain information will be written on a BacT/Alert printout containing the bottle identification. If no gram stain result was received call the lab at 905-683-2320 ext 1476 (days) x 1475 (evenings). File the RVHS printout into the dedicated binder.

On occasions where the RVHS BacT/Alert incubator capacity cannot handle all the new cultures, bottles that have not been incubated will be sent to this laboratory. Handle these bottles as per routine and load them into the BacT/Alert as new cultures.

**PROCESSING PROCEDURE:**

**KEYSTROKES**

Log into the system

1. Double Click on the **Order Entry Icon**
2. Click on **Aux. Order** field
3. Click **Next** or press **Enter**

**INSTRUCTIONS/RESULTS**

Order Entry Search Screen displays, cursor defaults to the **Billing** field

Type in **MEDITECH specimen number** from accompanying list (11BC0000#### or BacT/Alert printout. If “order not found”, contact LIS officer, **DO NOT** add an order in LIS. Order has to be ordered through Meditech for proper processing.

Search window displays with the order information
4. Click **Finish** or press **Enter**

   To open the order

5. Click **Edit Mode** icon

   To edit the order

6. Click on **Micro tab**

   To open the **SOURCE SCREEN**
   Ideally it should come in with the Date and Time Collected, if not, click Add/F6 2x to enter current date and time on Collected and Received Date and Time Received

   If specimen came with Collected date and time, click Add/F6 on Received and Plated date and time

7. **Save**

   Click on **SAVE icon** or **Control S** to save the order

8. Click **Yes** or type **Y**

   To answer the question **“Do you want to save the changes you made to order?”**

9. **Choose label printer**

   Click **OK** to print **Collection Label (for all collected specimens)**

**At BacT/Alert**

10. Log on

11. Go to **Quick Data Entry**

    Scan **SCC order number** barcode

12. Type or scan **bottle number** barcode

    Link Order with bottle

13. Press **Bottle data** icon

    Press **Yes** to save changes to the entry

14. Go to **Status** field and press “?” button

    Select **“Positive”** and press OK

15. Touch **Accession data** icon

    Press **Yes** to save changes to the entry

16. Press **Send Acc. Results** button

    Sends order information over to the LIS
17. Touch **Monitor** icon and press **Log off**

**Back to LIS**

18. At **Worklists**

Select “**BC posted-no Isolate**”

19. Scan the bottle or select order

To open up the order

20. At the media screen, go to the positive bottle,

Select 1 {**BC+**}

To generate subculture media

21. Click on the printer icon,

Click on **Subculture Media Labels**

Print subculture media labels

22. **Save**

Click on **Save icon** or control S to save the order.

23. Click **Yes**, or type **Y** or press **Enter**

To answer the question “Printing subculture media labels. Do you want to save the changes?”

24. **Select subculture media**

Click OK to print selected subculture media (media with **RED** check mark beside it)

25. **Choose label printer**

Click OK to print subculture media labels

26. If only the positive bottles are received, subculture, read the gram and document the Gram in the media field **“GRAMB”** only.

If the gram stain results appear different from the one written on the form from RVHS, call the RVHS lab and the RVHS ward with our result. Inform the Charge Technologist.

If subculture plates are sent to us with the bottle(s), label the plates and work-up isolates following the usual identification and susceptibility testing protocol.
Accessioning Fluids Received in Bacti-Alert Bottles (with EPR Label, NOT PD Effluent Dialysate and Bone Marrow)

**KEYSTROKES**

1. Double Click on the Order Entry Icon
2. Click on Aux. Order field
3. Click on Next or press Enter
4. Click Finish or press Enter
5. Click Edit Mode icon
6. Add test Fluid in BC bottle
7. Site
8. Click on Micro tab
9. Click on Media button

**INSTRUCTIONS/RESULTS**

Order Entry Search Screen displays, cursor defaults to the Billing field
Scan HDS barcode or type in HDS specimen number
Search window displays with the order information
To open the order
To edit the order
?BTLE test added
Type Received in BacT/Alert bottles or blood culture bottles
To open the SOURCE SCREEN
Ideally it should come in with the Date and Time Collected, if not, click Add/F6 3x to enter current date and time on Collected, Received and Plated Date and Time Received
If specimen came with Collected date and time, click Add/F6 on Received and Plated date and time

Media Screen window displays
10. Click on the **fluid test line**
   Cancel plates and THIO then go to a blank field to add appropriate blood culture bottles

11. Click on drop down button or **Add Media**
    **Search result** window displays list.
    Double click on the bottles received (FO2, FN) or (FO2, ANAO2) or choose # from keypad then click OK.

12. Click **OK**
    To close **Media Screen**

13. **Save**
    Click on **SAVE icon** or Control S to save the order

14. Click on **Yes** or type **Y**
    To answer the question “**Do you want to save the changes you made to order?**”

15. **Choose label printer**
    Click **OK** to print **Collection Label (for all collected specimens)**

16. **Order Entry Search Screen** displays.
    Cursor defaults to the **Billing** field

17. Click on **Order** field
    Scan **Order barcode** or type in **Order number**

18. Click on **Next** or press **Enter**
    Search window displays with the order information

19. Click on **Finish** or press **Enter**
    Order opens on **Read Mode**

20. Click on **Run Micro Result Entry** icon
    Order will bridge over to **Result Entry**

21. Go to **GM** line
    Add result “**D-Not applicable**”

22. Click **^F button** or **Control F**
    Finalizes the test

23. **Save**
    Click on **SAVE icon** or Control S to save the order

24. Click on **Yes** or type **Y**
    To answer the question “**Order _____ has been modified. Do you want to save the changes?**”

25. **Order Entry Search Screen** displays, cursor defaults to the **Billing** field
**ALWAYS** check the printout before attaching SCC labels to specimen
- this is where all the information from the EPR/HDS order will be downloaded

<table>
<thead>
<tr>
<th>SCC order #</th>
<th>L5210452</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient's name</td>
<td>SMITH, JOHN</td>
</tr>
<tr>
<td>Diagnosis</td>
<td>SBP</td>
</tr>
<tr>
<td>HIS ORDER #</td>
<td>12496400</td>
</tr>
<tr>
<td>HIS order # (double check with specimen before attaching SCC labels)</td>
<td></td>
</tr>
<tr>
<td>Order Comment</td>
<td>ORDER COMMENT</td>
</tr>
<tr>
<td>DISCONTINUED R TRIPLE LUMEN CATH TIP</td>
<td></td>
</tr>
</tbody>
</table>

Attach SCC label with the **93 extension** to specimen and **load bottle(s) in BacT/Alert machine**
Accessioning Specimens with EPR Label Using Shortcuts

**KEYSTROKES**

Log into the system

1. Double Click on the Order Entry Icon

**INSTRUCTIONS/RESULTS**

Order Entry Search Screen displays, cursor defaults to the Billing field. Ensure Open in Edit Mode box is checked.

2. Click on Aux. Order field

Scan HDS bar code or type in HDS specimen number
3. Press **Enter** or Click **Next**
   
   Search window displays with list of possible matches.

4. Arrow down/Press **Enter** on highlighted match
   
   Main Order Entry Screen appears

4. Click **Finish** or press **Enter**
   
   To open the order

5. Click on **Micro tab**
   
   To open the **SOURCE SCREEN**
   Ideally it should come in with the Date and Time Collected, if not, click Add/F6 2x to enter current date and time on Collected and Received Date and Time Received

   If specimen came with Collected date and time, click Add/F6 on Received date and time
Receiving Bacteriology Specimens Entered in a HIS (Hospital Information System) at Point of Collection

To receive and plate a HIS barcode labeled specimen and print LIS specimen and media labels. These specimens will come from the UHN (EPR), CHC (Meditech) or Ajax (Meditech).

Example: A urine specimen was collected at Toronto Hospital (Western Division). It was ordered and labeled in EPR on the hospital ward and received in EPR by Specimen Reception. The Microbiology lab will receive plate and generate LIS specimen/media labels.

KEYSTROKES

Log into the system

1. Double Click on the Order Entry Icon

Order Entry Search Screen displays, cursor defaults to the Billing field

2. Click on Aux. Order field

Scan HIS specimen barcode or type in HIS specimen number

3. Click Next or press Enter

Search window displays with the order information. Check to be sure it is correct and proceed to next step. If message Auxiliary Order not found appears, see appropriate manual section for EPR, Meditech or Cerner problems.

4. Click Finish or press Enter

To open the order

5. Click Edit Mode icon

To edit the order

6. Click on Micro tab

To open the SOURCE SCREEN
Ideally it should come in with the Date and Time Collected, if not, click Add/F6 2x to enter current date and time on Collected and Received Date and Time Received

NOTE: This document is Uncontrolled When Printed.
Any documents appearing in paper form that are not stamped in red “MASTER COPY” are not controlled and should be checked against the document (titled as above) on the server prior to use.

Management System\UHN_Mount Sinai Hospital Microbiology\Standard Operating Procedures\Bacteriology Procedures\
If specimen came with Collected date and time, click Add/F6 on Received date and time

7. Save
   Click on SAVE icon or Control S to save the order

8. Click Yes or type Y
   To answer the question “Do you want to save the changes you made to order?"

9. Choose label printer
   Click OK to print Collection Label (for all collected specimens)

10. Order Entry Search Screen displays, cursor defaults to the Billing field
Receiving Bacteriology Specimens Collected on the 4th Floor Specimen Collection Center

To receive a previously barcode labeled specimen and print media labels.

Example: A urine specimen was collected on the 4th floor. It was entered into the system to generate a specimen barcode label. The Microbiology lab will receive, plate and generate media labels. ie. Collected times and dates were entered, no received or plated times and dates were entered.

**KEYSTROKES**

Log into the system

1. Double Click on the **Order Entry Icon**

   **Order Entry Search Screen** displays, cursor defaults to the **Billing** field

2. Click on **Order** field

   Scan specimen barcode

3. Click **Next** or press **Enter**

   Search window displays with the order information

4. Click **Finish** or press **Enter**

   To open the order

5. Click **Edit Mode** icon

   To edit the order

6. Click on **Micro tab**

   To open the **SOURCE SCREEN**

   Ideally it should come in with the Date and Time Collected, if not, click Add/F6 2x to enter current date and time on Collected and Received Date and Time Received

   If specimen came with Collected date and time, click Add/F6 on Received date and time

7. **Save**

   Click on **SAVE icon** or **Control S** to save the order.
<table>
<thead>
<tr>
<th>Section: Bacteriology Procedures</th>
<th>Subject Title: <strong>Laboratory Information Systems Bench Procedure Manual</strong></th>
</tr>
</thead>
</table>

8. Click **Yes** or type **Y**

To answer the question **“Do you want to save the changes you made to order?”**

9. **Choose label printer**

Click **OK** to print **Collection Label (for all collected specimens)**

10. **Order Entry Search Screen** displays, cursor defaults to the **Billing** field
Receiving Serology Specimens Collected on the 4th Floor Specimen Collection Center

Blood received in the Microbiology Department is to be documented that it was received through the LIS.

**KEYSTROKES**

1. Double Click on the **Order Entry Icon**
2. Click on **Order** field
3. Click **Finish** or press **Enter**
4. Click **Edit Mode** icon
5. Click **Specimens** tab
6. Click **Coll/Rec All** icon
7. **Collected By:** drop down button
8. Click OK
9. **Save**
10. Click **Yes** or type **Y**

**INSTRUCTIONS/RESULTS**

- **Order Entry Search Screen** displays, cursor defaults to the **Billing** field
- Scan specimen barcode
- Search window displays with the order information. Check that the name matches that on tube.
- To edit the order
- Window displays
- **Verify specimen(s)** window displays
- Search Results window displays, Choose #1 ?NURS, click OK
- Collected and Received date and time documented
- Click on **SAVE icon** or **Control S** to save the order.
- To answer the question “Do you want to save the changes you made to Order #_______?”
11. **Choose label printer**  
Click **OK** to print **Collection Label** *(for all collected specimens)*  
If the label on the tube is missing the extension number “96” see John.

12. **Order Entry Search Screen** displays, cursor defaults to the **Billing** field
Editing Orders

Editing an Order (Specimens from Non-Interfaced Sites)

An example of adding Fungus culture to the sputum specimen from the previous exercise:

**KEYSTROKES**

Log into the system

1. Double Click on the **Order Entry Icon**
2. Click on the **MRN** or **Last Name** field
3. Click on **Next** button or press **Enter**
4. Click on **Next** button or press **Enter**
5. From the **Order Entry Keypad** click on **X**
6. Click on **D**

**INSTRUCTIONS/RESULTS**

**Order Entry Search Screen** displays, cursor defaults to the **Billing** field

Type in patient’s **MRN** or **Last Name**. (You can use the patient you created in Exercise 2)

Search patient by **MRN** or **Last Name**

List of MRN displays, choose correct MRN

If a similar name(s) exists in the system, a list will display on a window, look for a match.

Search window containing stays on the patient displays. Select the original stay. If the patient has more than one order entered into the system, list will display. Select the appropriate one, then click **Finish** button.

The Order Entry Screen on **Read Mode** displays with all the information from the original order. Click on **Edit Mode icon** or **F7** to edit the order.

Select More Micro>MOR

Select Fungus Culture
7. Press **Enter** or click **YES** to confirm adequate specimen before adding test.

8. **Save**
   
   Click on **Save icon** or **control S** to save the order.

9. **Click Yes**, or type **Y** or press **Enter**
   
   To answer the question “Do you want to save the changes you made to order #_____?”

10. **Order Entry Search Screen** displays, cursor defaults to the **Billing** field.
Add Additional Media to a New Specimen Ordered on a Previous Patient (Specimens from Non-Interfaced Sites)

Add a new order and add additional media for the specimen to a patient in the system.

Example: Add an ear swab to a previous patient and add an additional CHOC plate.

KEYSTROKES

Log into the system

1. Double Click on the Order Entry Icon

2. Click on the MRN or Last Name field

3. Click Next button or press Enter to search

4. Click Next button or press Enter

5. Click Finish

INSTRUCTIONS/RESULTS

Order Entry Search Screen displays, cursor defaults to the Billing field

Type in MRN or patient’s full or partial name.

A search window will display with one or more patients with their MRN. Select the correct patient.

A window will now display with your patient’s MRN, Name, Ward and various stays for your patient. Select the current stay (match the encounter # from the requisition).

If a specimen on that patient has been ordered, a list of previous lab orders will display. If this is a new specimen of the day for this patient click New button then choose New Order

To create a new order. Order Entry Screen displays. Cursor is defaulted to Req. by field
6. **Tab or Enter 9x**

To get to the **ID field** on the **Test Ordered Section** or you can simply click on it. The main **Order Entry Keypad** window will display.

**From the Order Entry Keypad:**

7. **P**

To select Miscellaneous Swab C&S

8. **Source**

Click on drop down button to display list. Click on appropriate Source or choose # from keypad

9. Click on **Add/F6 button 2x**

To document **Collected, Received time and date**

10. Click on **Media button**

**Media Screen** window displays

11. Click on a blank field on the test line (**SWAB**)

12. Click on drop down button or **Add Media**

**Search result** window displays list. Double click on CHOC or choose # from keypad then click OK.

13. Click **OK**

To close **Media Screen**

14. **Save**

Click on **SAVE icon** or **Control S** to save the order

15. Click **Yes** or type **Y**

To answer the question **“Do you want to save the changes you made to order?”**

16. **Choose label printer**

Click **OK** to print **Collection Label** (for all collected specimens)

17. **Order Entry Search Screen** displays, cursor defaults to the **Billing** field
## Cancel an Order (Specimens from Non-Interfaced Sites)

Cancel an entire order if a mistake has been made at order entry and the order has been saved.

**KEYSTROKES**

Log into the system

1. Double Click on the **Order Entry Icon**

2. Click on the **MRN** or **Last Name** field

3. Click on **Next** button or press **Enter**

4. Click on **Next** button or press **Enter**

5. Click on the test you want to cancel

6. Click **Yes** or type **Y**

7. **Enter cancellation reason** or **F5** for Canned Messages

### INSTRUCTIONS/RESULTS

**Order Entry Search Screen** displays, cursor defaults to the **Billing** field

Type in patient’s **MRN** or **Last Name**.

(You can use the patient you created in Exercise 2)

Search patient by **MRN** or **Last Name**.

List of MRN displays, choose correct MRN

If a similar name(s) exists in the system, a list will display on a window, look for a match.

Search window containing stays on the patient displays. Select the original stay. If the patient has more than one order entered into the system, list will display. Select the appropriate one, then click **Finish** button.

The Order Entry Screen on **Read Mode** displays with all the information from the original order. Click on **Edit Mode icon** or **F7** to edit the order.

Click **Cancel** button

To answer the question “Do you really want to cancel TBX”? 
8. Click **OK**

To save the cancellation message. Canceled test will be moved under **Cancelled** tab

9. Save

Click on **Save icon** or **control S** to save the order.

10. Click **OK**

You are about to Modify Verified Results!

11. Click **Yes**, or type **Y** or press **Enter**

To answer the question “Do you want to save the changes you made to order #_____?

12. **Order Entry Search Screen** displays, cursor defaults to the **Billing** field.
## Printing PHL Send Out Forms

<table>
<thead>
<tr>
<th>KEYSTROKES</th>
<th>INSTRUCTIONS/RESULTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Go to a Patient Order</td>
<td>Drop down menu appears.</td>
</tr>
<tr>
<td>(either via a Worklist or Result Entry)</td>
<td></td>
</tr>
<tr>
<td>2. Click on the Printer Icon from the Main Toolbar.</td>
<td>“Micro Results Entry” box appears</td>
</tr>
<tr>
<td>4. “Order has been modified”</td>
<td></td>
</tr>
<tr>
<td>Press “Yes” to save and proceed or</td>
<td></td>
</tr>
<tr>
<td>Press “No” to proceed without saving</td>
<td></td>
</tr>
<tr>
<td>4. Click on the blue downward arrow in the hi-lighted box.</td>
<td>List of Printers appears.</td>
</tr>
<tr>
<td>5. Choose Printer</td>
<td>Printer choice now appears in box</td>
</tr>
<tr>
<td>6. Under “Report Layout” click on the blue arrow</td>
<td>Option List appears</td>
</tr>
<tr>
<td>7. Choose <strong>MIC10A</strong> by double clicking or single clicking and then choosing “OK”</td>
<td>MIC10A appears as choice</td>
</tr>
<tr>
<td>8. Click “OK” to accept</td>
<td>PHL Report prints</td>
</tr>
</tbody>
</table>
Results Entry

**Result Entry One Order**

**KEYSTROKE**  
**INSTRUCTIONS/RESULTS**

**Searching for a Patient in Result Entry**

1. Select Results > Result Entry from the main menu. Result Entry Search Wizard is displayed.

2. Enter the desired search criteria (Search by: patient’s last name, MRN, SSN, etc.).

3. Click Next to continue. A list of patients displays matching the criteria entered.

**NOTE:** Enter only the information known to be correct. If incorrect information is entered, the desired patient may not apply to the search and therefore not appear on the search list. Entering the order number will take the user directly to that order in Results Entry.

4. Select the desired patient and press Enter. A list of order numbers displays for this patient.

5. Select the desired order and press Enter. The Result Entry window is displayed.

**Entering Isolate Information in Result Entry**

1. Highlight a test or media associated with the isolate. This will autopopulate the Test ID and/or Media ID field(s) in the Isolates tab.

2. From the Result Entry window, select the Isolates tab.

3. On the top section of the Isolates tab, enter any necessary information into the isolate fields.

4. Enter a number in the first available #column.
5. Click in each field to enter results. Some fields may have keypads display to facilitate result entry. Remember to turn the keypad off if you need to enter something by free text.

A typical example of entering isolate information is as follows:
1. Enter 1 in the # field.
2. Select the desired sensitivity modality (MIC, KB, or BP) and select the appropriate panel from the drop down list.
3. Select the appropriate ID panel from the drop down list.
4. Enter the user defined quantitation (1+, 2+, rare, few, etc.) in the Quantitation field.
5. Select an organism ID code (esccol, staaur, etc.) from the drop down list.
6. Add an isolate comment if necessary.
7. Click the Verify One or Verify All button to post the selected information.

**Generating Drugs**

1. Click the desired modality tab (MIC, KB, BP). The ordered panel will display in the Panel ID field.
2. Choose the correct isolate. The first isolate will be selected by default. If this is not the correct isolate, click the drop-down arrow in the Isolate field to display a list of isolates and select the appropriate one.
3. Click the **Generate Drugs** button. Antibiotics associated with the ordered panel will display in the Drug Name fields as well as any rules that may have been defined in the Drugs Setup file.

**Adding Media in Result Entry**

Example: To add COMM for Comments

1. From the Media section, click the Add Media button or press F9. The Select Media window is displayed.
2. Enter the desired search criteria. A list of media that matches the search criteria is displayed.
3. Select a media and click OK. The media is added into the first available Media ID field.
Drug Manipulation

Drugs can be added, cancelled, deleted, suppressed and unsuppressed as needed to ensure the desired information is sent to the physician. A brief description of each process is included below.

Adding a Drug

Select the desired sensitivity modality and click the Add Drug button and select the desired drug from the search window.

 Cancelling a Drug

Select the desired drug to cancel and click the Cancel Drug button.

Result: A red check will display in the Cancelled column.

NOTE: Remember the suppression field indicates drugs that have been cancelled (suppressed), based on suppression rules as defined in the Drugs Setup file, resulting in the ability to distinguish between manually suppressed drugs vs. rules suppressed drugs.

Deleting a Drug

The same rules apply to deletion of drugs that apply to tests and media. If the drug has been saved, it should be cancelled, not deleted. Deleting the drug removes the drug and any result associated with it.

Unsuppressing a Drug

There are times when a physician may request testing a drug that is normally suppressed with a suppression rule. To unsuppress the results, click the Cancel Drug button twice. The first click will add a red check (cancel) to the cancelled column, and the second click will add a green "A" (add). The drug is now added.
Isolate Suppression

As a rule, the isolates will report in the order in which they are entered in Results Entry. Usually, the order is numerical unless organisms have been suppressed from reporting. There may be reasons to suppress organisms from reporting (for example, polymorphic isolates that are identified as the same organism with the same drug results). Suppression can be accomplished by changing the numerical character to a letter. The organism is suppressed from being reported, yet maintains all the links with comments and drug results. This action can be useful for workload reporting.
Batch Resulting

MRSA Bench

1. Negative report: Negative - No methicillin-resistant Staphylococcus aureus (MRSA) isolated

Data Entered:

DBlue Media: 24hr – No Blue

TEST COMMENT: Negative - No methicillin-resistant Staphylococcus aureus (MRSA) isolated.

STATUS: Final

Procedure
1. IC/ Other Worklist - IC MRSA New Work
2. Press Enter or Click OK
3. Bridge to QC (yes or No)

4. Opens Micros [IC/OtherWorklist (ICMRN)]
5. Bottom Left of Screen: Click Mark (F8) grayed out – means active
Also displays total number of orders in Worklist and Marked orders

6. Scan Barcode Labels of Sample (No Blue Cols)

Red Check Mark will appear for scanned order

NOTE: This document is Uncontrolled When Printed.
Any documents appearing in paper form that are not stamped in red "MASTER COPY" are not controlled and should be checked against the document (titled as above) on the server prior to use.
Bottom of Worklist: Displays how many orders were marked

7. Click on Define MC (M) (Define a Media Comment)

8. Type: DBLUE then Click OK
9. If Keypad does not pop up, Click on Keypad (.Keyword) or Press Ctrl+K to activate.
10. From Keypad pick (DBLUE -1 0f 3) **24hr:** then Keypad (DBLUE -2 0f 3) **No Blue,** Click OK

11. Click on **Add Results** (Add Results to Patient Records)
   A window is displayed indicating how many orders qualified. The red check mark turns into a green exclamation point

<table>
<thead>
<tr>
<th>#</th>
<th>Order</th>
<th>Patient Name</th>
<th>Seq #</th>
<th>Ax</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>N1110030</td>
<td>TESTA,TESTB</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>N1240008</td>
<td>TEST,CBC</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

12. Click on **Remark** (Remark Previous Selections)
   Red Check Mark will reappear

<table>
<thead>
<tr>
<th>#</th>
<th>Order</th>
<th>Patient Name</th>
<th>Seq #</th>
<th>Ax</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>N1110030</td>
<td>TESTA,TESTB</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>N1240008</td>
<td>TEST,CBC</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>
13. Click on (Define a Test Comment) then Click 

(If Keypad does not pop up, Click on or Press Ctrl+K to activate)
14. From Keypad pick (MRS – 1 of 4)) NMRS, Click OK

15. Click on Set Status to Final, Click OK
16. Click on **Add Results ("F7")** (Add Results to Patient Records)

17. A window is displayed indicating how many orders qualified. The red check mark turns into a green exclamation point

<table>
<thead>
<tr>
<th>Order Number</th>
<th>Test Requested</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 N1100030</td>
<td>TESTA,TESTB</td>
</tr>
<tr>
<td>2 N1240008</td>
<td>TEST,CBC</td>
</tr>
</tbody>
</table>

18. To check one,
   18.1. Double click on Order Number – Opens Result Entry Screen for that order
   18.2. Check Test Comment (F8 to see the full comment)

   **Negative - No methicillin-resistant Staphylococcus aureus (MRSA) isolated.**
18.3 Check Media Comment

<table>
<thead>
<tr>
<th>#</th>
<th>Media ID</th>
<th>Media Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DBLUE</td>
<td>24h: No Blue</td>
</tr>
<tr>
<td>2</td>
<td>BENCH</td>
<td></td>
</tr>
</tbody>
</table>

18.4. Click on \(\times\) to close the Result Entry Screen for that order -Defaults to ICMRN Worklist

19. Click on \(\times\) to close ICMRN Worklist Screen, or Click \(\times\) to close Resulting Worklist
Use of Macro

USE Macro for Media Comment Entry
Auto –Result for Test Comment and Final Status

1. Negative report: Negative - No methicillin-resistant Staphylococcus aureus (MRSA) isolated

Data Entered:

DBlue Media: 24hr – No Blue

TEST COMMENT: Negative - No methicillin-resistant Staphylococcus aureus (MRSA) isolated.

STATUS: Final

Procedure
1. IC/ Other Worklist - IC MRSA New Work
2. Click OK
3. Bridge to QC (Yes or No)

4. Opens Micros [Resulting Worklist (ICMRN)]
5. Bottom Left of Screen: Click on Mark (F8) grayed out – means active
   Also displays total number of orders in Worklist and Marked orders

6. Scan Barcode Labels of Samples (No Blue Cols)

   Red Check Mark will appear for scanned orders.
Bottom of Worklist: Displays how many orders were marked

<table>
<thead>
<tr>
<th>#</th>
<th>Order</th>
<th>Patient Name</th>
<th>Seq #</th>
<th>Act</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>N1110030</td>
<td>TESTA,TESTB</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>N1240008</td>
<td>TEST,CBC</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>N1240012</td>
<td>TEST,ED</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

7. Double Click Macro Menu (24 hr No Blue)

A window is displayed indicating how many orders qualified. The red check mark turns into a green exclamation point

<table>
<thead>
<tr>
<th>#</th>
<th>Order</th>
<th>Patient Name</th>
<th>Seq #</th>
<th>Act</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>N1110030</td>
<td>TESTA,TESTB</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>N1240008</td>
<td>TEST,CBC</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

8. Click Remak ("K") (Remark Previous Selections)

Red Check Mark will reappear.

<table>
<thead>
<tr>
<th>#</th>
<th>Order</th>
<th>Patient Name</th>
<th>Seq #</th>
<th>Act</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>N1110030</td>
<td>TESTA,TESTB</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>N1240008</td>
<td>TEST,CBC</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>N1240012</td>
<td>TEST,ED</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

9. Click Auto-Result ("U") (Run Auto-Result Worklist)

A window is displayed indicating how many orders qualified. The red check mark turns into a green exclamation point

<table>
<thead>
<tr>
<th>#</th>
<th>Order</th>
<th>Patient Name</th>
<th>Seq #</th>
<th>Act</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>N1110030</td>
<td>TESTA,TESTB</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>N1240008</td>
<td>TEST,CBC</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

10. To check one,

10.1. Double click on an Order Number –Opens Result Entry Screen for that order
10.2. Check Test Comment (F8 to see the full comment)

**Negative - No methicillin-resistant Staphylococcus aureus (MRSA) isolated.**

10.3 Check Media Comment

<table>
<thead>
<tr>
<th>Media ID</th>
<th>Media Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBLUE</td>
<td>24h: No Blue</td>
</tr>
<tr>
<td>BENCH</td>
<td></td>
</tr>
</tbody>
</table>
10.4. Click ✗ to close the Result Entry Screen for that order -Defaults to ICMRN Worklist

11. Click ✗ to close ICMRN Worklist Screen or Click ✗ to close Resulting Worklist
Autoresulting

Auto Resulting – Urine

Negative Report: No Growth

Procedure:

1. Click on: AUTORESULTING WORKLIST
2. URINE – Urine No Growth (make sure you are in right worklist)
3. Click [Mark (SF)]
   Make sure to mark only the orders you created
4. Click [Auto-Result (^U)]
5. Check one order by double clicking the Order Number and Click on [Instant Report] (Instant Report)
   and then click [Print Preview]

Follow same procedure for the following worklist

URINE – No Growth
URINE – No Significant
URINM - Mixed
Resulting Worklist – Printing Labels

This procedure can be used from any worklist to print labels you need for workup.

Printing Labels on VRE Bench

BVRE plates exhibiting blue colonies

Procedure:

6. Double Click on: IC/Other Worklist
7. Go into IC VRE New Work (make sure you are in right worklist)
8. Make sure your macro menu box is open.
9. Click on located in the bottom left hand corner of your worklist.
10. Scan in the plates you need labels for.
11. Use Macro. i.e. 24h-SBVRE Blue
12. Click on located in the top right side of your worklist.
13. Click on “Media” at the top of your worklist.
14. Choose “Print Subculture Media Labels”…. 
Batch Resulting TB Old Worklist

Conditions: FA Result should have Final Result
For NEGATIVE RESULTS only

Procedure
1. QC/Send out Worklist – TBO- TB Culture Old

2. Press Enter or Click OK
3. Bottom Left of Screen: Click Mark – grayed out means active
   Also displays total number of orders in Worklist and Marked orders

4. Scan Barcode Labels of Sample
   Red Check Mark will appear for scanned order

   Code: 1 N1110030 TESTA,TESTB
   Code: 2 N1240008 TEST, CBC

   Bottom of Worklist: Displays how many orders were marked

---

NOTE: This document is Uncontrolled When Printed.

Any documents appearing in paper form that are not stamped in red "MASTER COPY" are not controlled and should be checked against the document (titled as above) on the server prior to use.

Management System\UHN_Mount Sinai Hospital Microbiology\Standard Operating Procedures\Bacteriology Procedures\
5. Click on (Define a Test Comment)

6. Move Cursor to TBPCR and highlight, press DELETE key, then Click

OK
7. From Keypad pick Z, Click **OK**
8. Click on Set Status to Final, Click **OK**
9. Click on Set Status

A window is displayed indicating how many orders qualified. The red check mark turns into a green exclamation point.

<table>
<thead>
<tr>
<th>Order Number</th>
<th>Test Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>N1110030</td>
<td>TESTA,TESTB</td>
</tr>
<tr>
<td>N1240008</td>
<td>TEST,CBC</td>
</tr>
</tbody>
</table>

10. To check one,

   18.1. Double click on Order Number –Opens Result Entry Screen for that order  
   18.2. Check Test Comment (F8 to see the full comment)
To Fax Instant Report – Result Entry - Micro

NOTE: Results must be verified first or they will be resulted as in-lab

KEYSTROKE | INSTRUCTIONS/RESULTS
---|---
1. Log on to SoftMic | Search Order Window appears
2. Double Click Result Entry Icon | Order Screen window appears
3. In Result Entry search screen: Enter Order Number | Instant Report window appears
4. Click Next | Fax Browser Window appears
5. Click Finish | Report Faxed (1 copy)
6. Click on Printer icon |
7. Click on Instant Report or Press I |
8. Click Fax to |
9. Select the appropriate fax number |
10. Number of copies: 1 (change if needed) |
11. Click OK |
Other Softmic Functions

**Starting/Stopping Interface**

**KEYSTROKE** | **INSTRUCTIONS/RESULTS**
---|---

To Start Interface

1. Log on to SoftMic
2. Click on Interfaces
3. Click on Interface Setup or Press S
4. Open the Instruments Mic file by clicking on the + sign
5. Click on the instrument
   - Bact/Alert GBACT
   - Vitek VITEK
   - BD Probtec BDPRO
   - Inoculab Dynacon INOCU
6. Click Start Interface Icon
7. Click OK

To Stop Interface

8. Log on to SoftMic
9. Click on Interfaces
10. Click on Interface Setup or Press S
11. Open the Instruments Lab file by clicking on the + sign
12. Click on the instrument
   - Bact/Alert GBACT
   - Vitek VITEK
   - BD Probtec BDPRO
   - Inoculab Dynacon INOCU
13. Click Stop Interface Icon
14. Click OK

NOTE: This document is Uncontrolled When Printed.
Any documents appearing in paper form that are not stamped in red "MASTER COPY" are not controlled and should be checked against the document (titled as above) on the server prior to use.
Manual Downloading – Vitek

**KEYSTROKE**

**INSTRUCTIONS/RESULTS**

**Downloading orders**

1. Log on to **SoftMic**
2. Click on Main Menu – **Interfaces**
3. Click on **Instrument Menu or Press I**
4. Highlight the Vitek and click **Create Loadlist**
5. Choose way of classifying orders and date range
6. Use Add all button to add all tests to list
7. Click OK button
8. Either right click on the desired order number or click on Mark button and scan in an order number
9. Click on the Download Selected Order numbers icon
10. Click OK.
SoftMic QC Entry

**KEYSTROKE** | **INSTRUCTION/RESULTS**
--- | ---
1. Choose a worklist to log onto | “Micro Results Entry” window pops up.
2. Choose “YES” to the question “Would you like to bridge to SoftMic QC” | The “Bridge” window will open and the “SoftMic QC Result Entry” screen appears.
4. Arrow down and press enter at the specific line where desired QC result is to be entered.
5. Enter results for each organism from keypad selection.
   *if all results entered are within expected limits, go to step 14.
6. If result entered is out of range, a window for result action will show on the screen.
7. Press F2 | look for options for actions to be taken
8. Arrow down to pick the appropriate action from the provided list
9. Press Enter then F12
10. Choose 2 “COMMR” if nothing on the list is desired
11. Press “Enter” | to go to the free text line
12. Type in an explanation or corrective action.
13. Press F12 | this saves QC result
14. Press 1 | to enter Lot number
15. Press F2 | to bring up a list of Action Codes
16. Press 6 for Lot Number
17. Press “Enter”

18. Enter Lot Number

19. Press F12 to save entry

20. Press 1 to enter Expiry Date

21. Press F2 to bring up a list of Action Codes

22. Press 4 for Expiry Date

23. Press “Enter”

24. Enter Expiry Date

25. Press F12 to save entry

26. Press F12 to save session

27. Press “Y” to answer “Confirm Modification” and save

28. Go to the next QC item to be recorded and proceed as above.

29. Press F12, then F1 to save session and close SoftMic QC

30. **Once in a worklist, To bridge to SoftMic QC, click on “Tools” in the Main Toolbar Drop down menu will appear

31. Choose SoftMic QC “Bridge” window to SoftMic QC will appear

32. Enter your ID

33. Enter your system password Screen defaults to 1-Tasks

34. Choose “E” (Results Entry) SoftMic QC Results Entry Screen appears

35. F12
36. Choose a “Task” from the list that corresponds to the bench QC needed.
   i.e. #3 BC-QC  Blood Culture Bench QC
   (move the cursor by arrowing down and/or paging down for more options)

37. F12

38. Proceed to enter QC (see Step 4).
SoftLab

LIS Serology- Introduction

Test Codes

Serology at the Department of Microbiology share the same SCC SoftLab module as MSH Pathology Department. To distinguish from 3000 other tests in the LIS, all Serology In House tests performed have test codes that start with 8, therefore a complete list can be obtained by entering 8, then F2 to search in any “test” field. Send-out tests start with the number 9 and Study/Research with number 10. Almost all non-blood Microbiology specimens are processed through the SCC SoftMic module (CSF antibodies are processed through the SoftLab module).

Instrument-Interfaced Tests

ARCHITECT, EVOLIS and COBAS AMPLILINK

The Abbot Architect communicates through a bidirectional interface ie. LIS downloads orders and patient demographics. Results upload back to the LIS. The extension number 96 for Architect and Evolis except Galactomannan BAL extension number 99 and for Amplilink/Taqman extension number is 04 at the end of the 8 digit LIS order number is required.

Other than HbsAg, numeric results initially produced by the Architect are first interpreted with in the Architect into text form (eg. REACTIVE, NEGATIVE, NONREACTIVE).

These results may not be reported until either the LIS translates them into a reportable format (e.g POSITIVE, Negative) or a technologist enters the result manually after performing and reviewing all required confirming tests (see Serology Bench Manual).

For HbsAg only
HbsAg values <0.049 are posted by Architect and then translated by LIS to Negative other results are posted as numeric values to LIS.

Automatic Downloading, Automatic Posting and the Report Scheduler eliminate most manual result entry. However, manual Architect result entry is still required for REACTIVE HbsAG, HBCab, HCV and HIS (see LIS Serology - Result Entry: By Test) Architect QC tests requires manual posting (see POSTING QC IN LIS).

Manual Tests
All other tests with out an instrument interface are regarded as Manual Tests. They should be resulted through Tasklists (Section 6 Result Entry: by Tasklist) which link to the required QC. Tasklists for Evolis tests are used to organizing the run, review the results and link to QC.

AXSYM Tests results for TGLN samples are printed out and results are entered manually in LIS.
Basic Lab Query

KEYSTROKE INSTRUCTIONS/RESULTS

The Lab Results Query window enables you to review specific test information.

Searching for Lab Results in Lab Results Query

1. Log on to SoftLab or SoftMic
2. Double click Lab Query Icon Results Query appears
3. **Patient Selection Area:**
   - Move cursor to MRN# and
   - Key in patient's Medical record Number
   
   Enter any available information at hand
   The more data you enter, the more specific
   the query results will be.

4. **Time Range Area:** defaults to **One Year:**
   (Time range can be changed by clicking on the drop down arrow)

5. **Format:** Click on **All Tests as Ordered**
   Click Advanced to add more than one test to query

6. Click **Query** Lab Results Query Window appears

7. Check Patient Information

8. Open Stay folder by clicking on the + sign List of Orders for that Stay appears
   in front of the folder

9. Click on the specific Order Displays results on Results Panel

10. Close the Lab Results Query Window to exit
**Bridging from Order Entry-Lab Query**

**KEYSTROKE**

4. Log on to **SoftLab** or **SoftMic**
5. Double Click **Order Entry** Icon
6. Enter any available information at hand.
   The more data you enter the more specific the query will be.
7. Click **Next** until the desired Order number with the test in query is found.
8. Double Click on the Order or Click Finish
9. In Order Entry Screen, Main Toolbar –
   Click on **Lab Query** Icon
10. Click on Order Number (with test you like to query)
11. Click on **Instant Report**
12. Change **Report Layout to RL10**
    **Report Format to RR10**
10. Click **Print Preview**

**INSTRUCTIONS/RESULTS**

Search Window appears

Order Entry Screen appears

Displays Report
Bridging from Result Entry-Lab Query

**KEYSTROKE** | **INSTRUCTIONS/RESULTS**
---|---
13. Log on to **SoftMic** | Microbiology Result Entry
14. Double Click **Result Entry** Icon | Window appears
15. Enter any available information at hand. (example Last Name, First Name and MRN given)
16. Click **Next** until the desired Order number with the test in query is found.
17. Click **Finish** | Micro Result Entry Screen appears
18. In Micro Result Entry Screen, Main Toolbar – Click on **Lab Query** Icon
19. Click on **Order Number** (with test you like to query)
20. Click on **Instant Report**
21. Click on **Print Preview** Displays Report
22. Change **Report Layout** to RL10  
    **Report Format** to RR10
**Fields and Buttons - Lab Query**

**Lab Results Query Window – Results Query**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name</td>
<td>Enter the patient’s last name or click the arrow button to display the search results screen and select a patient from the list.</td>
</tr>
<tr>
<td>First Name</td>
<td>Enter the patient’s first name or click the arrow button to display the search results screen and select a patient from the list.</td>
</tr>
<tr>
<td>DOB (Date of Birth)</td>
<td>Enter the patient’s date of birth or click the arrow button to display a calendar from which to choose a date.</td>
</tr>
<tr>
<td>Other Name</td>
<td>Select the check box to search by other name(s). This is used in conjunction with the Master Patient Index. MPI is an optional feature.</td>
</tr>
<tr>
<td>Phonetic Search</td>
<td>Select the check box if you want to use the phonetic search (Sondex) Contact SCC for the default setting in the corresponding hospital.</td>
</tr>
<tr>
<td>Billing</td>
<td>Enter the billing number that will identify the patient.</td>
</tr>
<tr>
<td>Order</td>
<td>Select the arrow button to select the order number to be included on the Results Query window.</td>
</tr>
<tr>
<td>Department of Microbiology</td>
<td>Policy # MI_LIS</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Quality Manual</td>
<td>Version: 1.1  CURRENT</td>
</tr>
</tbody>
</table>

| Section: Bacteriology Procedures           | Subject Title: Laboratory Information Systems Bench Procedure Manual |

NOTE: This document is Uncontrolled When Printed. Any documents appearing in paper form that are not stamped in red "MASTER COPY" are not controlled and should be checked against the document (titled as above) on the server prior to use.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MRN</td>
<td>Enter the Medical Record Number that will identify the patient, or click the arrow button to display a list of Medical Record Numbers from which to make a selection.</td>
</tr>
<tr>
<td>MPI #</td>
<td>Enter the Master Patient Index Number that identifies the patient. (MPI is an optional feature).</td>
</tr>
<tr>
<td>SSN</td>
<td>Enter the Social Security Number that identifies the patient. Enter a maximum of 9 numeric characters in the format XXX-XX-XXXX.</td>
</tr>
</tbody>
</table>
| Aux Order   | Enter the auxiliary order number that identifies the patient, if applicable.  

**NOTE:** The Aux Order field will display according to the hostparam, GUI_aux_ordno_display.

| Test        | Enter the test ID number or click the arrow button to display the test results and select from a list of defined numbers. |
| Ward        | Enter the clinic ID number or click the arrow button to display the clinic search screen and select from a list of defined wards. |
| Doctor      | Click the doctor drop-down arrow to select a doctor from the doctor search screen. Click the drop-down arrow to designate the type of doctor:  

- Req. - Requesting Doctor  
- Att. - Attending Doctor  

In the field adjacent to the doctor field, click the down arrow to display the Doctor Search Screen and select a doctor from the list. |
| Reg/Depot   | Click the arrow button to display a list of region(s)/depot(s) from which to make a selection. |
| Orders Sorted by Collection Time | Select the check box if you want to sort the orders by collection time. |
| Time Range  | Click the drop-down arrow to select one of the following options to search for orders within a specific time range:  

- One Day  
- One Week  
- One Month  
- One Year  
- Date Range (Default) |
| From/To Date | If you select Date Range in the previous field, these fields become available for use. Enter the range of dates you want to include in your query, or click the arrow button to display a calendar from which to choose a date for each field. |
| Format      | Click the option button next to the query format you want to use. If you select Other, enter the other format or click the arrow button (or press F2) to display a list of defined formats. Select from the following options:  

- QQ1  
- All tests as ordered |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defaults</td>
<td>From the Results Query window, click the Defaults button to Save, Clear, or</td>
</tr>
<tr>
<td></td>
<td>Restore. Restore a set of defaults.</td>
</tr>
<tr>
<td>Office Query</td>
<td>When data entry is complete, click Query to initiate the search. The Office</td>
</tr>
<tr>
<td></td>
<td>Query window is displayed.</td>
</tr>
<tr>
<td>Blood Bank Query</td>
<td>From the Results Query window, click the Blood Bank Query button to bridge</td>
</tr>
<tr>
<td></td>
<td>to Blood Bank. The Blood Bank Query Search window will display. After</td>
</tr>
<tr>
<td></td>
<td>entering your search criteria, click Next.</td>
</tr>
<tr>
<td>Advanced</td>
<td>From the Results Query window, you can click the Advanced button to open</td>
</tr>
<tr>
<td></td>
<td>the Advanced Test Criteria window. This window enables you to enter more</td>
</tr>
<tr>
<td></td>
<td>detailed search criteria.</td>
</tr>
<tr>
<td></td>
<td>NOTE: You can enter your search criteria in upper or lowercase font.</td>
</tr>
<tr>
<td>Query</td>
<td>When data entry is complete, click Query to initiate the search. The Lab</td>
</tr>
<tr>
<td></td>
<td>Results Query window is displayed.</td>
</tr>
<tr>
<td>Close</td>
<td>Click this button to close the window.</td>
</tr>
<tr>
<td>Clear</td>
<td>Click this button to remove entered data.</td>
</tr>
<tr>
<td>Open in New Window</td>
<td>The Open in New window enables you to perform a search that opens in a new</td>
</tr>
<tr>
<td></td>
<td>window. This enables you to perform multiple searches without losing the</td>
</tr>
<tr>
<td></td>
<td>patient data from previous searches.</td>
</tr>
</tbody>
</table>
Building Tasklist

KEYSTROKE

INSTRUCTIONS/RESULTS

Creating a Tasklist

1. Log on to **SoftLab**
2. Double Click on **Tasklist Icon**  
   Tasklist window appears
3. Click on **New Icon**  
   Defaults to **Processed**: last 3 days (change if needed)
4. **Creation Template**: Enter **Test Code (eg. 8VD)**, Click **drop down or Press F2** for list
5. Select **Status: pending and nonverified**
6. At samples 1.Q, 2.Q, 3.Q, etc. scan control barcodes for each control  
   For controls with numeric values QC names are entered automatically in the tasklist
7. Click **Add Missing or Press F6**, check that numbers displayed match samples then **“Yes”**  
   If you want to print screen to view and check order numbers against tubes in rack  
   a. Click **Printer Icon** in Tasklist Menu  
   b. Click **Print Preview**  
   DO NOT SAVE THE TASKLIST UNTIL IT MATCHES WHAT YOU HAVE.  
   Click **Delete Button or Press F8** to delete samples  
   Click **Insert or Press F5** to insert samples on the list
8. Click Save icon then **“Yes”**
9. Click **OK**
10. To print the Tasklist  
    a. Click **Printer Icon** in Tasklist Menu  
    b. **Print To**: Select Report Printer ID  
    c. Defaults to **Layout : TL_List**  
    d. Defaults to **Number of Copies: 1**  
    e. Click **OK**

11. When setting up the test run, record the lot# of the kit and expiry date on the Tasklist beside the controls.
12. After performing the test, manually record the results of the controls and patients samples on this original Tasklist. Ensure that the initials of the Tech performing the test and checking and verifying the test (if appropriate) is recorded.
Editing Tasklist

You may need to edit the tasklist that was created and saved before if you have more samples to add or delete from the list.

**KEYSTROKE**

13. Log on to **SoftLab**
14. Double Click on **Tasklist Icon**
15. Tasklist ID: Scan or Enter Tasklist ID
16. Highlight and Delete Tech ID (if you are not the one who created the tasklist)
17. Click Edit Icon
18. Click to the next available Field
   a. Click **Add Missing or Press F6**
      The Add Missing (F6) button enables you to add orders to the tasklist
   
   b. Click **Insert Button or Press F5**
      The Insert (F5) button enables you to insert an order between orders on the tasklist.
   
   b. Click **Delete Button or Press F8**
      The Delete (F8) button enables you to delete/remove orders from the tasklist.

19. Click **Save icon then click “Yes” to save**
20. Click **OK**
21. To print the Tasklist
   a. Click **Printer Icon** in Tasklist Menu
   b. **Print To: Select Report Printer ID**
   c. Defaults to **Layout : TL_List**
   d. Defaults to **Number of Copies: 1**
   e. Click **OK**
Reprinting Tasklist

KEYSTROKE

TO REPRINT TASKLIST
1. Double Click Tasklist Icon
2. Tasklist ID: Scan the Tasklist ID
3. Delete Tech ID
4. Click Open Folder Icon in Tasklist Menu
5. Click Printer Icon in Tasklist Menu
6. Print To: Select Report Printer ID
7. Defaults to Layout: TL_List
8. Defaults to Number of Copies: 1
9. Click OK

INSTRUCTIONS/RESULTS

Defaults to Tasklist ID

Test will be changed to “no tests qualified” once test is already resulted.
Fields And Buttons Descriptions - Tasklist

The following section provides reference information about the buttons, windows, and dialog boxes that correspond to the Tasklist option. This reference section provides quick information about the fields and buttons used when working in tasklist window.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Tasklist ID    | This field displays the Tasklist ID. When you create a new tasklist, the next available tasklist ID is automatically generated. Reference laboratory test can qualify for tasklists at the specimen/ordered test level for the system.

**NOTE:** The Tasklist can be utilized in Autotracking without the user having to rescan specimens into specimen tracking.

| Tech           | This field defaults to the technologist currently signed on to the system. If you want to change the technologist ID, click the arrow button (or press F2) to select from a list of valid technologists. |
| Creation Date/Time | These fields automatically default to the current date and time.                                                                                   |
### Field Description

**Creation Template**
This field displays the template code previously created for use in the tasklist. Enter the worklist template code previously created for use in this tasklist, or click the arrow button (or press F2) to display a list of all defined codes. Once a worklist template code is selected, the heading of the template displays to the right of the template code.

**Specimens only**
Check this box to access tests by specimen only.

**Qualification Type**
This field displays a qualification type. Click the drop-down arrow button to select a qualification type.
- **1-9** — This number of tests should be present on the order
- **A** — All tests should be present on the order
- **S** — At least one test should be present on the order

**Processed**
This field is used to specify a time frame during which, if specimens were processed, they will qualify to the tasklist. To enter a custom time frame, select Custom. The date that is used to qualify tests to the tasklist depends on what you select in the Status field.

**Status**
Used in conjunction with the Processed field. Select one of the following statuses for qualifying tests to the tasklist:
- **Pending** — Tests for which results have not been entered. Uses the collected date or to be collected date for the specimens.
- **Nonverified** — Tests for which results have been entered in the result database. Includes results manually or from instruments. Uses the result date.
- **Pend + Nonver** — Tests with both a pending and nonverified status (as described above). Uses the collected date or to be collected date for the specimens.
- **All** — Searches for all tests. Uses the collected date or to be collected date for the specimens.
- **Verified** — Tests for which results have been verified. Uses the verified date for the specimens.
- **Not Reviewed** — This option is used to compile a worklist of all tests that are to be reviewed. The test must be the first test on the worklist template and defined as an individual test in the Individual Tests Setup file. The result for a test must have pending in the result field or remain blank in order to appear on the list. The template must have all other test results completed/verified except for the review test.
- **Reviewable** — This option is used to compile a worklist of all tests that are reviewable. The test must be the first test on the worklist template and defined as an individual test in the Individual Tests Setup file. The template must have all other results completed/verified. The result for the test must have one of the following values: reviewed with results and verified, pending, or left blank. The difference between this option and not reviewed is that the test in question can have a result whether verified or not. Canceled
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Received</td>
<td>This box allows you to qualify the tests specimens if they have been received.</td>
</tr>
<tr>
<td>Reg/Depot</td>
<td>You can qualify the tests by a two-character depot code.</td>
</tr>
<tr>
<td>Type</td>
<td>This column indicates whether it is a “Q” QC specimen or an “S” standard specimen. This column is blank for a normal patient specimen.</td>
</tr>
<tr>
<td>Mark</td>
<td>This column indicates if a test has been marked for review on the tasklist window.</td>
</tr>
<tr>
<td>Specimen #</td>
<td>This column displays the order number related to the qualifying test/specimen.</td>
</tr>
<tr>
<td>Name (last, first, middle)</td>
<td>This column displays the patient name related to the qualifying order.</td>
</tr>
<tr>
<td>Ward</td>
<td>This column displays the ward as it is defined in the ward setup.</td>
</tr>
<tr>
<td>Coll.</td>
<td>This column displays the tests specimen collected time.</td>
</tr>
<tr>
<td>Recv.</td>
<td>This column displays the tests specimen received time.</td>
</tr>
<tr>
<td>Prior.</td>
<td>This column displays the tests specimen priority.</td>
</tr>
<tr>
<td>Tests</td>
<td>This column displays the qualifying test from the task list template.</td>
</tr>
<tr>
<td>Barcode</td>
<td>This field displays the scanning barcode identifier for the selected test order.</td>
</tr>
<tr>
<td>Spec ID</td>
<td>This column displays the specimen tube type for the qualifying test.</td>
</tr>
<tr>
<td>Wkst</td>
<td>This column displays the performing workstation for the qualifying test.</td>
</tr>
<tr>
<td>Auxiliary#</td>
<td>This column displays the HIS order number.</td>
</tr>
</tbody>
</table>

**NOTE:** This document is *Uncontrolled When Printed.* Any documents appearing in paper form that are not stamped in red “MASTER COPY” are not controlled and should be checked against the document (titled as above) on the server prior to use.
**Table:**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Missing button (F6)</td>
<td>The Add Missing (F6) button enables you to add orders to the tasklist. To add order the tasklist, click the Add Missing button or press F6.</td>
</tr>
<tr>
<td>Insert Button (F5)</td>
<td>The Insert (F5) button enables you to insert an order between orders on the tasklist. To insert an order on the tasklist in between orders, click the Insert button or press F5.</td>
</tr>
<tr>
<td>Delete Button (F8)</td>
<td>The Delete (F8) button enables you to delete/remove orders from the tasklist. To delete/remove orders from the tasklist, select the line number for the order, then click the Delete button or press F3.</td>
</tr>
<tr>
<td>Send to Ref. Lab button</td>
<td>The Send to Ref. Lab button enables you to display the Request for Reference Lab window is displayed.</td>
</tr>
<tr>
<td>Search</td>
<td>This button allows you to search for the specimen's barcode identifier.</td>
</tr>
</tbody>
</table>
Result Entry – One Order Number

You may need this to enter the results of test performed that requires the use of a keypad, ie results that are REACTIVE in initial testing and repeat testing was done. HCA negative results (also on rare occasions, HBsAb or HBeAg, VZ-NEGATIVE need to be changed from “neg” to “Negative” in LIS). Manual tests for which a tasklist are made are best entered under Result Entry by Tasklist

KEYSTROKE

To enter Result
1. Log on to SofLab
2. Double Click Result Entry icon
3. Click on Order field and Scan or manually Enter Order Number
4. Click Next
5. Enter QC results at this time (if appropriate)
   a. The Results for QC entry box appears when the QC was not yet entered on that day
   b. if not Click QC Current Result (+)
      or Press SHIFT and + at the same time
   c. Click on QC result field and enter result
   d. After all QC results are entered Click Close
5. Automatically saves the entry.
7. Enter Patient Result using the keypad.
8. Click Save Icon then “Yes” to save

INSTRUCTIONS/RESULTS
Result Entry - Batch Resulting (Tasklist)

This type of result entry is used for manual test for which a tasklist was made: VDRL, Monospot, HTLE, VZ, 8HAGE etc.

**KEYSTROKE**

**INSTRUCTIONS/RESULTS**

1. Log on to SoftLab
2. Double Click **Batch Resulting Worklist Icon**
   Batch Worklist window appears
3. Click drop down and select **Tasklist**
4. Scan or Enter Tasklist number manually
5. Click on **Test** drop down
6. Click **OK**

Enter QC results at this time (if appropriate)

a. Results for QC when the QC was not yet entered on that day
b. Open up Result Entry window for one order by pressing **enter** on highlighted order

c. Click **QC Current Result (+)**
   or **Press SHIFT and +** at the same time
   Results for QC Window appears

d. Click on **QC result field** and enter result

e. After all QC results are entered Click **Close**
   Automatically saves the entry.

f. Close the Result Entry Screen of the **Order**
   Brings you back to tasklist

7. Click **Mark All** or **Press Ctrl+A** (if you want to enter the same to all the numbers)
   **If you want to enter result on selected Orders only**
   a. Click on the **Order Number**
   b. Click **Mark** or **Press Space Bar**
   or **Right Click** on Mark field of the Order
   Marks Order
   c. Repeat Steps a and b until all Orders are marked

8. Click **Add Result** or **Press Ctrl+F7**
   Result Mark Orders window appears

9. Using the keypad,(Press Ctrl + K to display keypad) then enter result

10. You have option to verify or not at this point, Add Message, Add Result Comment, Add Specimen comment
11. Click **Save Icon**, then **“Yes”** to save
### Verifying Result – One Order

**KEYSTROKE**

<table>
<thead>
<tr>
<th>INSTRUCTIONS/RESULTS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To verify results of one Order Number</strong></td>
</tr>
</tbody>
</table>

1. Log on to **SofLab**
2. Double Click **Result Entry** icon
3. Click on **Order field** and Scan or manually Enter Order Number
4. Click **Next**
5. To verify one test (highlight the one you wanted to verify) Click **Verify**, then Click **Save** Icon then “Yes” to save
6. Click **Verify All** if you wanted to verify all the test results you entered then “Yes” to save.
Verifying Result – Tasklist

**KEYSTROKE**

**INSTRUCTIONS/RESULTS**

To check if results are entered correctly and to verify tests from Tasklist

1. Log on to **SoftLab**
2. Double Click **Batch Resulting Worklist** icon
   - Batch Worklist window appears
   - Defaults Select tests by: Tests
3. Click **drop down** and select **Tasklist**
4. Scan or Enter Tasklist number manually
   - Test Template appears, Creation date
   - And Tech User Id appears
5. Click on test **drop down**
   - Test Code appears
6. Click **OK**
   - Empty Tasklist appears
7. Click **Not Verified or Press Ctrl+8** (Filters- left hand side)
   - Orders not yet verified in that specific worklist are listed.
8. Open up Result Entry window for one order by pressing enter on highlighted order
   - Or double click on Order Number
9. To verify one test (highlight the one you wanted to verify) Click **Verify** or Press “ [ “
   - then Click **Save** Icon then “Yes” to save
10. Click **Verify All or Press “ ; ”** if you wanted to verify all the tests results you entered
    - then “Yes” to save.
**Fields and Buttons Descriptions – Result Window**

**Results Window – Patient Demographics Area**
The top area of the Results window is the patient demographics area. It displays the patient and order information for the selected order.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name (last, first, middle)</td>
<td>This field displays the patient’s full name.</td>
</tr>
<tr>
<td>MRN</td>
<td>This field displays the patient’s MRN.</td>
</tr>
<tr>
<td>Sex</td>
<td>This field displays the patient’s gender.</td>
</tr>
<tr>
<td>Age</td>
<td>This field displays the patient’s age.</td>
</tr>
<tr>
<td>Ward</td>
<td>This field displays the ward associated with the patient.</td>
</tr>
<tr>
<td>Room</td>
<td>This field displays the patient’s room number.</td>
</tr>
<tr>
<td>Order</td>
<td>This field displays the patient’s order number.</td>
</tr>
<tr>
<td>Prior</td>
<td>This field displays the priority of the order (R=Routine, U=Urgent, S=Stat, T=Timed).</td>
</tr>
<tr>
<td>Aux#</td>
<td>This field displays the HIS order number.</td>
</tr>
<tr>
<td>Collected</td>
<td>This field displays the collected date and time for the order.</td>
</tr>
<tr>
<td>Tests</td>
<td>This field displays all ordered test on the patient’s order.</td>
</tr>
<tr>
<td>Call</td>
<td>This field opens the Call box where the user can mark an order to be called, complete a call, remove a call, or view the call history.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>More Button</td>
<td>The More button enables you to view additional patient information. To view additional patient information (for example, insurance information, etc.), click More.</td>
</tr>
<tr>
<td>Comment(s)</td>
<td>This field opens a read-only comment box that shows all entered free-form text or canned message comments and the tags associated with the patient.</td>
</tr>
<tr>
<td>EXAMPLE: Patient comments, Order comments, Specimen comments, or Test comments.</td>
<td></td>
</tr>
<tr>
<td>Spec Comment</td>
<td>This field opens the Specimen Comment box that allows the user to enter free-form text in a specimen comment or a canned message.</td>
</tr>
</tbody>
</table>
Results Window - Result Information Area

The bottom area of the Results window is the Result Information Area.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>T Ind</td>
<td>This column displays the ID for the individual test. If there is a group test in the T Ord cell, the individual test(s) will be listed in this cell. The system will default information into this cell.</td>
</tr>
<tr>
<td>Result</td>
<td>Enter the result for each test. This cell will accept alphanumeric characters as dictated by the ranges in Individual Test Setup.</td>
</tr>
<tr>
<td>Fl</td>
<td>Displays symbolic representation of the flag associated with the result.</td>
</tr>
<tr>
<td>Flags</td>
<td>The Flags button enables you to display all Order Entry flags associated with the selected test. Click the Flags toolbar button to display flags associated with the test selected. The Flags field displays a written description of the flag associated with result. The size of the field can be changed by clicking the vertical line and dragging it to the left or right. The flags are as follows:</td>
</tr>
</tbody>
</table>
### Laboratory Information Systems Bench Procedure Manual

#### Section: Bacteriology Procedures

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>low normal</td>
</tr>
<tr>
<td>H</td>
<td>high normal</td>
</tr>
<tr>
<td>AB</td>
<td>abnormal</td>
</tr>
<tr>
<td>ABL</td>
<td>abnormal low</td>
</tr>
<tr>
<td>AGH</td>
<td>abnormal high</td>
</tr>
<tr>
<td>P</td>
<td>panic</td>
</tr>
<tr>
<td>PL</td>
<td>panic low</td>
</tr>
<tr>
<td>PH</td>
<td>panic high</td>
</tr>
<tr>
<td>A, X</td>
<td>absord</td>
</tr>
<tr>
<td>XL</td>
<td>absurd low</td>
</tr>
<tr>
<td>XH</td>
<td>absurd high</td>
</tr>
<tr>
<td>%D% delta failed</td>
<td></td>
</tr>
<tr>
<td>aD</td>
<td>absolute delta failed</td>
</tr>
</tbody>
</table>

No flag indicates that the test result was normal.

**M**
A check mark in this column indicates that there is a comment attached to the test. The system will default information in this field.

**Prev Res**
This column displays the previous result value for the test. The system will look back through the current stay for a previous value of that test and display it in this column. Read only column.

**C**
This field indicates that the result is based on a calculation.

**Prev Date**
This column displays the date of the previous result value for the test.

**Status**
This column displays each status that applies to the result of the test. The following is a list of the possible status characters that apply to this column:
- L — labeled, indicates the specimen has been labeled.
- C — collected, indicates the specimen has been collected (if both the L and C flags are present the specimen has been received).
- D — downloaded, indicates the ordered test has been downloaded to an instrument.
- P — posted, indicates the result has been posted from an instrument.
- V — verified, indicates the result has been verified.
- R — reported, indicates that a patient report has been printed (for instance, single-sheet reported, chart reported, or discharge reported).
- E — edited, indicates the current result displayed has been edited.
- X — reflexed, indicates the test was reflexed.
- ! — called, indicates the result has been called and no longer qualifies to the call list.
- + — indicates that review is required.

**Tech**
This column indicates the technician who performed the test.

**Date V**
The date the test was verified will default into this field upon verification of the result. This column cannot be edited.

**Time V**
The time the test was verified will default into this field upon verification of the result. This column cannot be edited.
### Field Description

#### T Ord
This field displays the test ID as it was ordered in Order Entry. The system defaults information into this field.

#### TAT Status
The three settings for this field indicate the status of the "turnaround time" for the particular test. The settings include:
- Green box with arrows – The TAT has not exceeded 90% of the maximum TAT.
- Yellow box with arrows – The TAT has exceeded 90% of the maximum TAT.
- Red box with arrows – The maximum TAT has been exceeded. The maximum TAT time is determined in Setup > Tests Maintenance.

#### Units
This read-only field displays the units of measure for the test.

#### QC Status
This field displays the QC status for an individual test. The status may be passed or failed. Passed QC status indicates that the test may be resubmitted. If the status is failed, the test may not be resubmitted.

#### Wrkst
This field indicates the workstation where the test is being performed.

#### Spec
This field indicates the specimen type.

#### D
"D" displays a symbolic representation of the delta flag associated with the result. The size of this field may be modified by clicking the vertical line and dragging it to the left or right. The symbols are as follows:
- Blue % symbol – Percent of delta failure.
- Green "A" symbol – Absolute delta failure.

#### Date
This read-only field indicates the date the result was entered in the system. Once a result is entered, the current date will automatically populate this field.

#### Time
This read-only field indicates the time the result was entered in the system. Once a result is entered, the current time will automatically populate this field.

#### Prev Time
This column displays the time of the previous result value for the test.

#### Prev Order
This column displays the order number of the previous result value for the test.

#### T Name
This column displays the test name that is listed in the T Ind column. The test name comes from the Test Name field in the test setup.

#### T Ind S
This column displays the second ID that comes from the second ID field in the test setup.

### Button Description

#### Comment Button
The Comment button enables you to add a comment for the result. Click the Comment button, or select the shortcut \, to enter a comment for the current specimen.

#### Coll/Rec Button
The Coll/Rec button enables you to collect and receive the specimen at the same time. Click the Coll/Rec button, press CTRL+P or choose Specimens > Coll/Rec from the Results window to display a window that enables you to collect and receive the specimen at the same time.

#### Verify Button
The Verify button enables you to verify one result at a time. Click the Verify button to verify a result.

#### Verify All Button
The Verify All button enables you to verify all the results at the same time. Click the Verify All button to verify all the results.
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Button</td>
<td>The Check button enables you to check result information. Click the Check button to display the Result Information window.</td>
</tr>
<tr>
<td>Cancel Button</td>
<td>The Check button enables you to cancel a specifically selected test.</td>
</tr>
<tr>
<td>Rev Button</td>
<td>The Rev button enables you to mark the result for Pathologist review. Click the Rev button or choose Results &gt; Rev to mark the result to go to the Pathologist for review. Only tests that have results can be marked for review. Any test that is marked for review will display a plus sign (+) within the Status column.</td>
</tr>
<tr>
<td>Failed reason Button</td>
<td>The Failed reason button enables you to view why a test failed to render a result.</td>
</tr>
<tr>
<td>Canned Msg Button</td>
<td>The Canned Msg button enables you to enter a canned message for a result. Enter leading characters of the canned message, or click the Canned Msg button, or choose Results &gt; Message to add a canned message to this result. A list of defined messages displays. Select the desired message and press ENTER. The verification window then displays.</td>
</tr>
<tr>
<td>Def Res Button</td>
<td>The Default Res button enables you to enter a default result. Click the Default Res button, press F2, or choose Results &gt; Default to enter default result.</td>
</tr>
<tr>
<td>Tst Hist Button</td>
<td>The Test History button enables you to view a test’s history. Click the Test History button or choose Results &gt; Test History to view a test’s history.</td>
</tr>
<tr>
<td>Res Info Button</td>
<td>The Res Info button enables you to open a Change Resulting Information window.</td>
</tr>
<tr>
<td>Customize Button</td>
<td>The Customize button enables you to open the Show Columns window where you can select the columns you want to display on the results grid.</td>
</tr>
<tr>
<td>Show Spec Button</td>
<td>The Show Spec button opens the specimen information window.</td>
</tr>
<tr>
<td>Formulary Button</td>
<td>The Formulary button enables you to print the formulary for the displayed test ID.</td>
</tr>
<tr>
<td>Scattergram Button</td>
<td>The Scattergram button enables you to view automated differential results. This is only available with certain Hematology analyzers. If this function is desired, contact SCC to determine if it is available with the analyzer you are using.</td>
</tr>
</tbody>
</table>

Note: To see more functions right click anywhere in Result Information Area.

Failed reason Button does not apply for this version
Fields and Buttons Descriptions - Tasklist

The following section provides reference information about the buttons, windows, and dialog boxes that correspond to the Tasklist option. This reference section provides quick information about the fields and buttons used when working in tasklist window.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tasklist ID</td>
<td>This field displays the Tasklist ID. When you create a new tasklist, the next available tasklist ID is automatically generated. Reference laboratory test can qualify for tasklists at the specimen/ordered test level for the system. NOTE: The Tasklist can be utilized in Autotracking without the user having to rescan specimens into specimen tracking.</td>
</tr>
<tr>
<td>Tech</td>
<td>This field defaults to the technologist currently signed on to the system. If you want to change the technologist ID, click the arrow button (or press F2) to select from a list of valid technologists.</td>
</tr>
<tr>
<td>Creation Date/Time</td>
<td>These fields automatically default to the current date and time.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Creation Template</td>
<td>This field displays the template code previously created for use in the tasklist. Enter the worklist template code previously created for use in this tasklist, or click arrow button (or press F2) to display a list of all defined codes. Once a worklist template code is entered, the heading of the template displays to the right of the template code.</td>
</tr>
<tr>
<td>Specimens only</td>
<td>Check this box to access tests by specimen only.</td>
</tr>
<tr>
<td>Qualification Type</td>
<td>This field displays a qualification type. Click the drop-down arrow button to select a qualification type.</td>
</tr>
<tr>
<td></td>
<td>• 1-9 — This number of tests should be present on the order</td>
</tr>
<tr>
<td></td>
<td>• A — All tests should be present on the order</td>
</tr>
<tr>
<td></td>
<td>• S — At least one test should be present on the order</td>
</tr>
<tr>
<td>Processed</td>
<td>This field is used to specify a time frame during which, if specimens were processed, they will qualify to the tasklist. Select Custom. The date that is used to qualify tests to the tasklist depends on what you select in the Status field.</td>
</tr>
<tr>
<td>Status</td>
<td>Used in conjunction with the Processed field. Select one of the following statuses for qualifying tests to the tasklist:</td>
</tr>
<tr>
<td></td>
<td>• Pending — Tests for which results have not been entered. Uses the collected date or to be collected date for the specimens.</td>
</tr>
<tr>
<td></td>
<td>• Nonverified — Tests for which results have been entered in the result database. Includes results manually or from instruments. Uses the resulted date.</td>
</tr>
<tr>
<td></td>
<td>• Pend + Nonver — Tests with both a pending and nonverified status (as described above). Uses the collected date or to be collected date for the specimens.</td>
</tr>
<tr>
<td></td>
<td>• All — Searches for all tests. Uses the collected date or to be collected date for the specimens.</td>
</tr>
<tr>
<td></td>
<td>• Verified — Tests for which results have been verified. Uses the verified date for the specimens.</td>
</tr>
<tr>
<td></td>
<td>• Not Reviewed — This option is used to compile a worklist of all tests that are to be reviewed. The test must be the first test on the worklist template(s) and defined as an individual test in the Individual Tests Setup file. The result for test must have pending in the result field or remain blank in order to appear on the list. The template must have all other test results completed/verified except for the review test.</td>
</tr>
<tr>
<td></td>
<td>• Reviewable — This option is used to compile a worklist of all tests that are reviewable. The test must be the first test on the worklist template(s) and defined as an individual test in the Individual Tests Setup file. The template must have all other results completed/verified. The result for the test must have one of the following values: reviewed with results and verified, pending, or left blank. The difference between this option and not reviewed is that the test in question can have a result whether verified or not. Canceled</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Received only</td>
<td>This box allows you to qualify the tests specimens if the have been received.</td>
</tr>
<tr>
<td>Reg/Depot</td>
<td>You can qualify the tests by a two-character depot code.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The depot of the user's terminal default into the depot field when</td>
</tr>
<tr>
<td></td>
<td>creating a Tasklist, when that terminal is defined in the Multisite Depot</td>
</tr>
<tr>
<td></td>
<td>setup table. The system will leave the depot field empty if the terminal is</td>
</tr>
<tr>
<td></td>
<td>not defined in the Depot setup. The user can change the default setting in</td>
</tr>
<tr>
<td></td>
<td>the Depot field as needed.</td>
</tr>
<tr>
<td>Type</td>
<td>This column indicates whether it is a &quot;Q&quot; QC specimen or an &quot;S&quot; standard</td>
</tr>
<tr>
<td></td>
<td>specimen. This column is blank for a normal patient specimen.</td>
</tr>
<tr>
<td>Mark</td>
<td>This column indicates if a test has been marked for review on the tasklist</td>
</tr>
<tr>
<td>Specimen #</td>
<td>This column displays the order number related to the qualifying test/specimen.</td>
</tr>
<tr>
<td>Name (last, first, middle)</td>
<td>This column displays the patient name related to the qualifying order.</td>
</tr>
<tr>
<td>Ward</td>
<td>This column displays the ward as it is defined in the ward setup.</td>
</tr>
<tr>
<td>Coll.</td>
<td>This column displays the tests specimen collected time.</td>
</tr>
<tr>
<td>Recv.</td>
<td>This column displays the tests specimen received time.</td>
</tr>
<tr>
<td>Prior.</td>
<td>This column displays the tests specimen priority.</td>
</tr>
<tr>
<td>Tests</td>
<td>This column displays the qualifying test from the task list template.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The exact number of required tests can be defined for task list</td>
</tr>
<tr>
<td></td>
<td>qualification in Template setup using the hosparm, TL_AltAreaFormat &quot;RE_TASKREP&quot;.</td>
</tr>
<tr>
<td></td>
<td>Additionally, non-qualifying but related verified test results from previous orders can be defined to print on the tasklist. Information from the related test results that may pertain to the qualifying tests will be included on the tasklist for a specified time frame. If these additional tests are not verified, they will show as &quot;pending&quot;.</td>
</tr>
<tr>
<td>Barcode</td>
<td>This field displays the scanning barcode identifier for the selected test order.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The Tasklist option has the ability to scan a barcode printed on the Standard and the Alternate Tasklist formats.</td>
</tr>
<tr>
<td>Spec ID</td>
<td>This column displays the specimen tube type for the qualifying test.</td>
</tr>
<tr>
<td>Wkst</td>
<td>This column displays the performing workstation for the qualifying test.</td>
</tr>
<tr>
<td>Auxiliary#</td>
<td>This column displays the HIS order number.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Add Missing button (F6)</td>
<td>The Add Missing (F6) button enables you to add orders to the tasklist. To add order the tasklist, click the Add Missing button or press F6.</td>
</tr>
<tr>
<td>Insert Button (F5)</td>
<td>The Insert (F5) button enables you to insert an order between orders on the tasklist. To insert an order on the tasklist between orders, click the Insert button or press F5.</td>
</tr>
<tr>
<td>Delete Button (F8)</td>
<td>The Delete (F8) button enables you to delete/remove orders from the tasklist. To delete/remove orders from the tasklist, select the line number for the order, then click the Delete button or press F8.</td>
</tr>
<tr>
<td>Send to Ref. Lab button</td>
<td>The Send to Ref. Lab button enables you to display the Request for Reference Lab window is displayed.</td>
</tr>
<tr>
<td>Search</td>
<td>This button allows you to search for the specimen's barcode identifier.</td>
</tr>
</tbody>
</table>
# Fields and Buttons Descriptions - Result Search Window

## Search for Order Window

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select tests by</strong></td>
<td>In the Select Tests By field, select one of the following options from the drop-down list:</td>
</tr>
<tr>
<td><strong>Template</strong></td>
<td>Selecting the Templates option displays a field in which to enter the worklist template code. Click the arrow button (or press F2) to list all defined codes to select one to insert into this field. A template lists all tests that are to appear on the appropriate worklist when created. To use a counting keypad (for example, , manual differential), Result Entry by template must be selected.</td>
</tr>
<tr>
<td><strong>Workstation</strong></td>
<td>Displays a field in which to enter the workstation ID. Click the arrow button (or press F2) to list all defined codes to select one to insert into this field. All tests belonging to this workstation are retrieved. This option is especially useful when entering results from reference laboratories since all tests performed by a given reference lab should have the same Workstation ID (for example, , IML, SK, REF1, etc.).</td>
</tr>
<tr>
<td><strong>Tests</strong></td>
<td>Displays fields for you to enter up to 8 individual or group test codes. Click the arrow button (or press F2) to display a search screen. Select the desired test code and click OK, or press ENTER to insert into this field.</td>
</tr>
<tr>
<td><strong>All Active</strong></td>
<td>When chosen, all orders that are currently active are available for result entry after defining the remaining criteria.</td>
</tr>
<tr>
<td><strong>All</strong></td>
<td>When chosen, all orders that are active and non-active are available for Result Entry after defining the remaining criteria.</td>
</tr>
</tbody>
</table>

**NOTE:** The Tests, All active, and All options are not recommended for use due to the space and time constraints on the system for processing.

<table>
<thead>
<tr>
<th>Order</th>
<th>This field enables you to enter the order number.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient name</td>
<td>This field enables you to enter the patient’s name.</td>
</tr>
<tr>
<td>MRN</td>
<td>This field enables you to enter the patient’s MRN.</td>
</tr>
<tr>
<td>Billing</td>
<td>This field enables you to enter the billing number.</td>
</tr>
</tbody>
</table>
**Fields and Buttons - Interface**

**Select Instrument and Results Window Field Descriptions**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Instrument</td>
<td>Select your desired instrument from the Select Instrument pane.</td>
</tr>
<tr>
<td>Select Date</td>
<td>After choosing a specific instrument, select your desired date, or double-click to see all results for the current month. Click the heading to sort by date or by the number of results.</td>
</tr>
</tbody>
</table>
| What to Display      | Click the drop-down arrow to select one of the following options:  
                           • All - displays all results  
                           • Not Posted - displays results not posted                                                                 |
| Starting From        | Enter part or all of the order/sequence number (based on the How to Display field) to edit all more recent records, or leave the field blank to start with the first record.  
                           **NOTE:** Order numbers consist of the month, day, and sequence number as usual, plus a two-digit extension; (this is the Bar Code Suffix assigned in the Specimen/Tube Types Setup File. |
| How to Display       | Click the drop-down arrow to select one of the following options:  
                           • By Order Displays results by Order number  
                           • By Sequence Displays results by Sequence number                                                                 |
| Ending At            | Enter data or leave set at the default ZZZZZZZZZZZ to search for the latest result.                                                         |
| Comment(s) Button    | The Comments button enables you to enter (or view existing) a comment in the Comment window. A check mark will display if there is a comment.       |
| Spec Comm Button     | The Spec Comm button enables you to enter (or view existing) a comment in the Comment window. A check mark will display if there is a comment.       |
### Instrument Menu Window – Patient Demographics Work Area

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name (last, first, middle)</td>
<td>This field displays the patient’s last, first and middle names. This is a display-only field.</td>
</tr>
<tr>
<td>MRN</td>
<td>This field displays the Medical Record Number assigned to the patient. This number is unique and can be system generated, manually entered, or taken from the HIS.</td>
</tr>
<tr>
<td>Sex</td>
<td>This field displays the patient’s gender.</td>
</tr>
<tr>
<td>Age</td>
<td>This field displays the patient’s age.</td>
</tr>
<tr>
<td>Ward</td>
<td>This field displays the patient’s ward.</td>
</tr>
<tr>
<td>Room</td>
<td>This field displays the patient’s room.</td>
</tr>
<tr>
<td>More Button</td>
<td>The More button displays the Patient Information window, which allows you to view additional information about the patient, as well as relative insurance data.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> To view insurance information, click the Insurance tab.</td>
</tr>
<tr>
<td>Order</td>
<td>This field displays the order number, including the two-digit extension (based on the Barcode Suffix assigned in the Specimen/Tube Types Setup file, see Setup – Specimen Tube Types).</td>
</tr>
<tr>
<td>Prior</td>
<td>This field displays the order’s priority.</td>
</tr>
<tr>
<td>Seq</td>
<td>This field displays the sequence number.</td>
</tr>
<tr>
<td>Spec</td>
<td>This field displays the specimen tube type.</td>
</tr>
<tr>
<td>Collected</td>
<td>This field displays the collected date.</td>
</tr>
<tr>
<td>Tests</td>
<td>This field displays the patient’s test.</td>
</tr>
<tr>
<td>Button</td>
<td><strong>Call Button</strong> The Call button enables you to display the Call window, with Call List information. A check mark displays in this button if call information has been entered in the Call window.</td>
</tr>
</tbody>
</table>

Any documents appearing in paper form that are not stamped in red “MASTER COPY” are not controlled and should be checked against the document (titled as above) on the server prior to use.
Instrument Menu Window – Instrument Tab

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment(s) Button</td>
<td>The Comments button enables you to enter (or view existing) a comment in the Comment window. A check mark will display if there is a comment.</td>
</tr>
<tr>
<td>Spec Comm Button</td>
<td>The Spec Comm button enables you to enter (or view existing) a comment in the Comment window. A check mark will display if there is a comment.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>List</td>
<td>This column displays a list of orders with all of the corresponding order information. This is the default setting for the instrument loadlist view.</td>
</tr>
<tr>
<td>Stst</td>
<td>This column displays the system code names of the tests chosen by the sort option.</td>
</tr>
<tr>
<td>Result</td>
<td>This column displays the result associated with the test.</td>
</tr>
<tr>
<td>Fl</td>
<td>This column displays symbolic representation of the flag associated with the result.</td>
</tr>
<tr>
<td>Flags</td>
<td>This column displays the specific flag associated with the test result.</td>
</tr>
<tr>
<td>M</td>
<td>A check mark in this column indicates that there is a comment attached to the test. The system will default information in this column.</td>
</tr>
<tr>
<td>Prev Res</td>
<td>This column displays the previous test result.</td>
</tr>
<tr>
<td>Prev Date</td>
<td>This column displays the previous test date.</td>
</tr>
</tbody>
</table>
| Error | This column displays the error code from the Error translation table. For example, "L" may signify too low and "0" may represent no sample found.  

**NOTE:** Select Error Message from the View menu or place the mouse cursor over the error code to view the error description from the Error Translation Table. |
| Status| This column displays each status that applies to the result of the test. The following is a list of the possible status characters that apply to this column:  
- **L**: Labeled, indicates the specimen has been labeled.  
- **C**: Collected, indicates the specimen has been collected (if both the L and C flags are present the specimen has been received).  
- **D**: Downloaded, indicates the ordered test has been downloaded to an instrument.  
- **P**: Posted, indicates the result has been posted from an instrument.  
- **V**: Verified, indicates the result has been verified. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>R</strong>: Reported, indicates the result has qualified to a single sheet report and the report has been printed. The result has been flagged as reported in the report option.</td>
</tr>
<tr>
<td></td>
<td><strong>E</strong>: Edited, indicates the current result displayed has been edited</td>
</tr>
<tr>
<td></td>
<td><strong>X</strong>: Reflected, indicates the test was reflected.</td>
</tr>
<tr>
<td></td>
<td><strong>I</strong>: Canceled, indicates the result has been canceled and no longer qualifies to the call list.</td>
</tr>
<tr>
<td></td>
<td><strong>+</strong>: Indicates review is required</td>
</tr>
<tr>
<td>Tech</td>
<td>The ID of the resulting tech will default into this column upon result entry. This column cannot be edited.</td>
</tr>
<tr>
<td>DateV</td>
<td>This column displays the date the test was verified.</td>
</tr>
<tr>
<td>TimeV</td>
<td>This column displays the time the test was verified.</td>
</tr>
<tr>
<td>DateP</td>
<td>Date posted</td>
</tr>
<tr>
<td>TimeP</td>
<td>Time posted</td>
</tr>
<tr>
<td>T ind S</td>
<td>The individual test ID.</td>
</tr>
<tr>
<td>T Name</td>
<td>The test name</td>
</tr>
<tr>
<td>Wrkst</td>
<td>The ordering/performing workstation.</td>
</tr>
<tr>
<td>Prev Order</td>
<td>Previous order number</td>
</tr>
<tr>
<td>D</td>
<td>Delta checking indicator (if delta checking is out for test result)</td>
</tr>
<tr>
<td>QC Status</td>
<td>Displays the QC status (performed, out, timed out)</td>
</tr>
<tr>
<td>Units</td>
<td>The units of the test</td>
</tr>
<tr>
<td>TAT Status</td>
<td>Turn around time status (white, green, yellow or red)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comm [ent] Button</td>
<td>The Comm button enables you to add a comment for the result. Click the Comm button to add a comment for the current result.</td>
</tr>
<tr>
<td>Post All Button</td>
<td>The Post All button enables you to post all results for the test.</td>
</tr>
<tr>
<td>Part Post Button</td>
<td>The Part Post button enables you to post tests individually.</td>
</tr>
<tr>
<td>Rerun&amp;DnLoad Button</td>
<td>To toggle the rerun status for the selected order, click the Rerun&amp;DnLoad Button. The entire order will be rerun.</td>
</tr>
<tr>
<td>Rerun Rep Button</td>
<td>The Rerun report button enables you to rerun the selected report.</td>
</tr>
<tr>
<td>Check Button</td>
<td>The Check button enables you to check result information. Click the Check button to display the Result Information window.</td>
</tr>
<tr>
<td>Canned Msg Button</td>
<td>The Canned Msg button enables you to enter a canned message for a result. Enter leading characters of the canned message (or press [ ] or click the Cnd Msg button to add a canned message to this result. A list of defined messages displays. Select the desired message and press ENTER. The verification window then displays.</td>
</tr>
</tbody>
</table>
## Instrument Menu Window – Results Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>The column displays the order number.</td>
</tr>
<tr>
<td>Flags</td>
<td>This column displays the current status/flags that are set for a particular order (for example, “Q” = Quality Control Record or “S” signifying a Stat order).</td>
</tr>
<tr>
<td>Seq #</td>
<td>This column displays the sequence numbers.</td>
</tr>
<tr>
<td>T #</td>
<td>The T # column displays the total number of tests.</td>
</tr>
<tr>
<td>Time</td>
<td>This column displays the time the order was run on a particular analyzer.</td>
</tr>
<tr>
<td>Test list</td>
<td>The column displays the tests.</td>
</tr>
<tr>
<td>Barcode</td>
<td>This column displays the barcode.</td>
</tr>
<tr>
<td>Specimen ID</td>
<td>This column displays the setup ID for tube type.</td>
</tr>
<tr>
<td>TAT Status</td>
<td>This column displays the turnaround for testing.</td>
</tr>
<tr>
<td>R Date</td>
<td>This column displays the received date.</td>
</tr>
<tr>
<td>R Time</td>
<td>This column displays the received time.</td>
</tr>
<tr>
<td>C Date</td>
<td>This column displays the collected date.</td>
</tr>
<tr>
<td>C Time</td>
<td>This column displays the collected time.</td>
</tr>
<tr>
<td>Instrum</td>
<td>The column displays the instrument ID.</td>
</tr>
<tr>
<td>Aux Order</td>
<td>This column displays an alternate patient ID from Order Entry.</td>
</tr>
</tbody>
</table>
Starting/Stopping Interface

KEYSTROKE

To Start Interface

15. Log on to SoftLab
16. Click on Interfaces
17. Click on Interface Setup or Press S
18. Open the Instruments Lab file by clicking on the + sign
19. Click on the instrument
   Evolis EVOLS
   Abbott Architect ARCHI
   Cobas Amplilink AMPLI
20. Click Start Interface Icon
21. Click OK

INSTRUCTIONS/RESULTS

Interface Set-up window appears
List of Instruments appears
Action Report window appears

To Stop Interface

22. Log on to SoftLab
23. Click on Interfaces
24. Click on Interface Setup or Press S
25. Open the Instruments Lab file by clicking on the + sign
26. Click on the instrument
   Evolis EVOLS
   Abbott Architect ARCHI
   Cobas Amplilink AMPLI
27. Click Stop Interface Icon
28. Click OK

Action Report window appears
MANUAL POSTING – AMPLILINK

KEYSTROKE

Posting Manual Results

11. Log on to SoftLab

12. Click on Main Menu – Interfaces

13. Click on Instrument Menu or Press I

14. Click on 6 AMPLI Cobas Amplilink

15. Select Date: Choose (Click) the file date that you want to post

16. Select What to Display: Not Posted

   How to Display: By Order

17. Click OK

   Instrument Menu Appears list of Orders not yet posted (Flags -empty)

(IF Flag is V; it means it was already posted)

18. Click on the Order Number you wanted to post

19. Review the result in the interface with the result sheet from Amplilink

20. DO NOT POST THE ORDERS THAT NEEDS TO BE REPEATED (ex. dilution to be done)

21. Click Post All Test button or Press “; “

22. For Partial Posting

   Click to the test you want to post first then Click Partial Posting button or Press “[ “

23. Click “Yes” to verify result with posting

24. Click Next Icon to go to the next order

25. Click x Button on Instrument Menu Window to exit.

Posting calculated values after dilution:

For one Order:

1. Log on to SoftLab

2. Click on Main Menu – Interfaces

3. Click on Interface Menu or Press I

4. Click on 6 AMPLI Cobas Amplilink

5. Select Date: Choose (Click) the file date that you want to post

6. Select What to Display: All

   How to Display: By Order

   Starting At: Scan the Order number or Enter the Order number with ext 96 at the end
<table>
<thead>
<tr>
<th>Ending At: same number as above</th>
</tr>
</thead>
<tbody>
<tr>
<td>7. Click <strong>OK</strong> Instrument Menu Appears Defaults Result field</td>
</tr>
<tr>
<td>8. Change result to calculated value</td>
</tr>
<tr>
<td>1. Click on result field</td>
</tr>
<tr>
<td>2. Type over the old result with the calculated value</td>
</tr>
<tr>
<td>3. Click “Yes” to save</td>
</tr>
<tr>
<td>12. Click Post All <strong>Test</strong> button or Press “; “</td>
</tr>
<tr>
<td>13. Click “<strong>Yes</strong>” to verify result with posting</td>
</tr>
<tr>
<td>14. Click <strong>x</strong> Button on Instrument Menu Window to exit</td>
</tr>
</tbody>
</table>

If you have more than one Order to change result and post follow **Posting Manual Results Steps** above
FIELDS AND BUTTONS- INTERFACE

Select Instrument and Results Window Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Instrument</td>
<td>Select your desired instrument from the Select Instrument pane.</td>
</tr>
<tr>
<td>Select Date</td>
<td>After choosing a specific instrument, select your desired date, or double-click to see all results for the current month. Click the heading to sort by date or by the number of results.</td>
</tr>
<tr>
<td>What to Display</td>
<td>Click the drop-down arrow to select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>- All - displays all results</td>
</tr>
<tr>
<td></td>
<td>- Not Posted - displays results not posted</td>
</tr>
<tr>
<td>Starting From</td>
<td>Enter part or all of the order/sequence number (based on the How to Display field) to edit all more recent records, or leave the field blank to start with the first record.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong>: Order numbers consist of the month, day, and sequence number as usual, plus a two-digit extension; (this is the Bar Code Suffix assigned in the Specimen/Tube Types Setup File).</td>
</tr>
<tr>
<td>How to Display</td>
<td>Click the drop-down arrow to select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>- By Order - Displays results by Order number</td>
</tr>
<tr>
<td></td>
<td>- By Sequence - Displays results by Sequence number</td>
</tr>
<tr>
<td>Ending At</td>
<td>Enter data or leave set at the default ZZZZZZZZZZZ to search for the latest result</td>
</tr>
<tr>
<td>Comment(s) Button</td>
<td>The Comments button enables you to enter (or view existing) a comment in the Comment window. A check mark will display if there is a comment.</td>
</tr>
<tr>
<td>Spec Comm Button</td>
<td>The Spec Comm button enables you to enter (or view existing) a comment in the Comment window. A check mark will display if there is a comment.</td>
</tr>
</tbody>
</table>
### Instrument Menu Window – Patient Demographics Work Area

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name (last, first, middle)</td>
<td>This field displays the patient’s last, first and middle names. This is a display-only field.</td>
</tr>
<tr>
<td>MRN</td>
<td>This field displays the Medical Record Number assigned to the patient. This number is unique and can be system generated, manually entered, or taken from the HIS.</td>
</tr>
<tr>
<td>Sex</td>
<td>This field displays the patient’s gender.</td>
</tr>
<tr>
<td>Age</td>
<td>This field displays the patient’s age.</td>
</tr>
<tr>
<td>Ward</td>
<td>This field displays the patient’s ward.</td>
</tr>
<tr>
<td>Room</td>
<td>This field displays the patient’s room.</td>
</tr>
<tr>
<td>More Button</td>
<td>The More button displays the Patient Information window, which allows you to view additional information about the patient, as well as relative insurance data.</td>
</tr>
</tbody>
</table>

**NOTE:** To view insurance information, click the Insurance tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>This field displays the order number, including the two-digit extension (based on the Barcode Suffix assigned in the Specimen/Tube Types Setup file, see Setup – Specimen Tube Types).</td>
</tr>
<tr>
<td>Prior</td>
<td>This field displays the order’s priority.</td>
</tr>
<tr>
<td>Seq</td>
<td>This field displays the sequence number.</td>
</tr>
<tr>
<td>Spec</td>
<td>This field displays the specimen tube type.</td>
</tr>
<tr>
<td>Collected</td>
<td>This field displays the collected date.</td>
</tr>
<tr>
<td>Tests</td>
<td>This field displays the patient’s test.</td>
</tr>
</tbody>
</table>

### Call Button

The Call button enables you to display the Call window, with Call List information. A check mark displays in this button if call information has been entered in the Call window.
### Instrument Menu Window – Instrument Tab

<p>| Comment(s) Button | The Comments button enables you to enter (or view existing) a comment in the Comment window. A check mark will display if there is a comment. |
| Spec Comm Button  | The Spec Comm button enables you to enter (or view existing) a comment in the Comment window. A check mark will display if there is a comment. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lfst</td>
<td>This column displays a list of orders with all of the corresponding order information. This is the default setting for the instrument loadlist view.</td>
</tr>
<tr>
<td>Stst</td>
<td>This column displays the system code names of the tests chosen by the sort option.</td>
</tr>
<tr>
<td>Result</td>
<td>This column displays the result associated with the test.</td>
</tr>
<tr>
<td>FI</td>
<td>This column displays symbolic representation of the flag associated with the result.</td>
</tr>
<tr>
<td>Flags</td>
<td>This column displays the specific flag associated with the test result.</td>
</tr>
<tr>
<td>M</td>
<td>A check mark in this column indicates that there is a comment attached to the test. The system will default information in this column.</td>
</tr>
<tr>
<td>Prev Res</td>
<td>This column displays the previous test result.</td>
</tr>
<tr>
<td>Prev Date</td>
<td>This column displays the previous test date.</td>
</tr>
</tbody>
</table>
| Error | This column displays the error code from the Error translation table. For example, "L" may signify too low and "0" may represent no sample found.  

**NOTE:** Select Error Message from the View menu or place the mouse cursor over the error code to view the error description from the Error Translation Table. |
| Status | This column displays each status that applies to the result of the test. The following is a list of the possible status characters that apply to this column:  
- L: Labeled, indicates the specimen has been labeled.  
- C: Collected, indicates the specimen has been collected (if both the L and C flags are present the specimen has been received).  
- D: Downloaded, indicates the ordered test has been downloaded to an instrument.  
- P: Posted, indicates the result has been posted from an instrument  
- V: Verified, indicates the result has been verified. |
<table>
<thead>
<tr>
<th>Section: Bacteriology Procedures</th>
<th>Subject Title: Laboratory Information Systems Bench Procedure Manual</th>
</tr>
</thead>
</table>

NOTE: This document is Uncontrolled When Printed.
Any documents appearing in paper form that are not stamped in red “MASTER COPY” are not controlled and should be checked against the document titled as above on the server prior to use.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Reported, indicates the result has qualified to a single sheet report and</td>
</tr>
<tr>
<td></td>
<td>the report has been printed. The result has been flagged as reported in the</td>
</tr>
<tr>
<td></td>
<td>report option.</td>
</tr>
<tr>
<td>E</td>
<td>Edited, indicates the current result displayed has been edited</td>
</tr>
<tr>
<td>X</td>
<td>Reflected, indicates the test was reflected.</td>
</tr>
<tr>
<td>T</td>
<td>Called, indicates the result has been called and no longer qualifies to the</td>
</tr>
<tr>
<td></td>
<td>call list.</td>
</tr>
<tr>
<td>+</td>
<td>Indicates review is required</td>
</tr>
<tr>
<td>Tech</td>
<td>The ID of the resulting tech will default into this column upon result entry.</td>
</tr>
<tr>
<td></td>
<td>This column cannot be edited</td>
</tr>
<tr>
<td>DateV</td>
<td>This column displays the date the test was verified.</td>
</tr>
<tr>
<td>TimeV</td>
<td>This column displays the time the test was verified.</td>
</tr>
<tr>
<td>DateP</td>
<td>Date posted</td>
</tr>
<tr>
<td>TimeP</td>
<td>Time posted</td>
</tr>
<tr>
<td>T Ind S</td>
<td>The individual test ID</td>
</tr>
<tr>
<td>T Name</td>
<td>The test name</td>
</tr>
<tr>
<td>Wrrkst</td>
<td>The ordering/performing workstation.</td>
</tr>
<tr>
<td>Prev Order</td>
<td>Previous order number</td>
</tr>
<tr>
<td>D</td>
<td>Delta checking indicator (if delta checking is cut for test result)</td>
</tr>
<tr>
<td>QC Status</td>
<td>Displays the QC status (performed, out, timed out)</td>
</tr>
<tr>
<td>Units</td>
<td>The units of the test</td>
</tr>
<tr>
<td>TAT Status</td>
<td>Turn around time status (white, green, yellow or red)</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>Comm [ent]</td>
<td>The Comm button enables you to add a comment for the result. Click the Comm</td>
</tr>
<tr>
<td></td>
<td>button to enter a comment for the current result.</td>
</tr>
<tr>
<td>Post All</td>
<td>The Post All button enables you to post all results for the test.</td>
</tr>
<tr>
<td>Part Post</td>
<td>The Part Post button enables you to post tests individually.</td>
</tr>
<tr>
<td>Rerun&amp;DnLoad</td>
<td>To toggle the rerun status for the selected order, click the Rerun&amp;DnLoad</td>
</tr>
<tr>
<td></td>
<td>Button. The entire order will be rerun.</td>
</tr>
<tr>
<td>Rerun Rep</td>
<td>The Rerun report button enables you to rerun the selected report.</td>
</tr>
<tr>
<td>Check</td>
<td>The Check button enables you to check result information. Click the Check</td>
</tr>
<tr>
<td></td>
<td>button to display the Result Information window.</td>
</tr>
<tr>
<td>Canned Msg</td>
<td>The Canned Msg button enables you to enter a canned message for a result.</td>
</tr>
<tr>
<td></td>
<td>Enter leading characters of the canned message (or press [ ] or click the Cnd</td>
</tr>
<tr>
<td></td>
<td>Msg button to add a canned message to this result. A list of defined messages</td>
</tr>
<tr>
<td></td>
<td>displays. Select the desired message and press ENTER. The verification window</td>
</tr>
<tr>
<td></td>
<td>then displays.</td>
</tr>
</tbody>
</table>
### Instrument Menu Window – Results Tab

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tst Hist Button</td>
<td>The Tst Hist button enables you to view a test's history. Click the Tst Hist button to view a test's history.</td>
</tr>
<tr>
<td>Scat Button</td>
<td>This button enables you to display a scattergram of the currently selected test.</td>
</tr>
<tr>
<td>QC Last Res Button</td>
<td>The QC Last Res Button enables you to display the last QC results run.</td>
</tr>
<tr>
<td>QC Comm Button</td>
<td>The QC Comm button enables communication with quality control.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>The column displays the order number.</td>
</tr>
<tr>
<td>Flags</td>
<td>This column displays the current status/flags that are set for a particular order (for example, , “Q” = Quality Control Record or “S” signifying a Stat order).</td>
</tr>
<tr>
<td>Seq #</td>
<td>This column displays the sequence numbers.</td>
</tr>
<tr>
<td>T #</td>
<td>The T # column displays the total number of tests.</td>
</tr>
<tr>
<td>Time</td>
<td>This column displays the time the order was run on a particular analyzer.</td>
</tr>
<tr>
<td>Test list</td>
<td>The column displays the tests.</td>
</tr>
<tr>
<td>Barcode</td>
<td>This column displays the barcode.</td>
</tr>
<tr>
<td>Specimen ID</td>
<td>This column displays the setup ID for tube type.</td>
</tr>
<tr>
<td>TAT Status</td>
<td>This column displays the turnaround for testing.</td>
</tr>
<tr>
<td>R Date</td>
<td>This column displays the received date.</td>
</tr>
<tr>
<td>R Time</td>
<td>This column displays the received time.</td>
</tr>
<tr>
<td>C Date</td>
<td>This column displays the collected date.</td>
</tr>
<tr>
<td>C Time</td>
<td>This column displays the collected time.</td>
</tr>
<tr>
<td>Instrum</td>
<td>The column displays the instrument ID.</td>
</tr>
<tr>
<td>Aux Order</td>
<td>This column displays an alternate patient ID from Order Entry.</td>
</tr>
</tbody>
</table>
# Toolbars - Interface

## Instrument Menu Window Toolbar Button Descriptions

The following functions are accessible from the Instruments Menu toolbar or from the corresponding menu.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Open icon]</td>
<td>Open</td>
<td>To open an existing record, click the Open button, press CTRL + O, or select Instrument &gt; Open.</td>
</tr>
<tr>
<td>![Open Results for Desired Date icon]</td>
<td>Open Results for Desired Date</td>
<td>To select and activate different result files, click the Open Results for Desired Date button. Once the button is selected, a result file selection window is displayed.</td>
</tr>
<tr>
<td>![Save Loadlist and/or Results list icon]</td>
<td>Save Loadlist and/or Results list</td>
<td>To save the loadlist and/or the results list you have added or edited, click the Save button, select File &gt; Save, or press CTRL + S.</td>
</tr>
<tr>
<td>![Reread loadlist/Results list icon]</td>
<td>Reread loadlist/Results list</td>
<td>To refresh the results list with new information (changes/additions/deletions) made to specific interface setups, click the Reread loadlist/Results list icon or press F5.</td>
</tr>
<tr>
<td>![Print icon]</td>
<td>Print</td>
<td>To print the currently displayed record to a specified printer, click the Print button or select File &gt; Print.</td>
</tr>
<tr>
<td>![Bridge to Order Entry icon]</td>
<td>Bridge to Order Entry</td>
<td>To bridge to the Order Entry option, click the Bridge to Order Entry button.</td>
</tr>
<tr>
<td>![Bridge to Worklist icon]</td>
<td>Bridge to Worklist</td>
<td>To go to the Result Entry screen (Worklist entry) for manual result entry, click the Bridge to Worklist button or press the &quot;T&quot; key.</td>
</tr>
<tr>
<td>![Bridge to QC Label icon]</td>
<td>Bridge to QC Label</td>
<td>To print labels for Quality Control Specimens in QC, click the Bridge to QC Label button or press Alt + T + L.</td>
</tr>
<tr>
<td>![Previous Record icon]</td>
<td>Previous Record</td>
<td>To go to the previous record, click the Previous Record button.</td>
</tr>
<tr>
<td>![Next Record icon]</td>
<td>Next Record</td>
<td>To advance to the next record, click the Next Record button.</td>
</tr>
<tr>
<td>![Help Topics icon]</td>
<td>Help Topics</td>
<td>To display overview help information for the current window, click the Help Topics button or select Help &gt; Help Topics.</td>
</tr>
</tbody>
</table>
## Icon | Name | Description
--- | --- | ---
![Help (F1)](image) | Help (F1) | To display help information for any field, button, checkbox, or option button, click the Help button, press F1, or select Help > What’s This.
![Run Report (CTRL+R)](image) | Run Report (CTRL+R) | To display the Available Reports window, click the Run Report button or press CTRL + R, or select Tools > Run Report. Select the report that you want to generate and click OK.
![Launch Report Viewer (SHIFT+F2)](image) | Launch Report Viewer (SHIFT+F2) | To view reports that have been generated and then saved in electronic format, click the Launch Report Viewer (SHIFT+F2) button or press SHIFT + F2, or select Tools > View Existing Report.
![Lab Results Query](image) | Lab Results Query | To bridge to the Lab Results Query option, click the Lab Results Query button or select Tools > Lab Results Query. The system queries the database and displays lab results information for the current record.
![Specimen Tracking](image) | Specimen Tracking | To bridge to the Specimen Tracking option, click the Specimen Tracking button or select Tools > Specimen Tracking.
![Check Printers](image) | Check Printers | To clear a printer or stop a print job, click the Check Printers button.
![Printer Status](image) | Printer Status | To view the current status of all printers, click the Printer Status button.
![Toggle Cancel Status](image) | Toggle Cancel Status | To toggle the status between Canceled and Original, click the Toggle Cancel Status button, or click Results > Cancel.
![Corresponding Loadlist / Results records](image) | Corresponding Loadlist / Results records | To view the Loadlist Menu, click the Corresponding Loadlist/Results records button or tab. The number that displays on the Loadlist tab shows the number of records stored in the Loadlist database for the selected instrument interface.
![Open Interface Setup](image) | Open Interface Setup | As a quick bridge to view or maintain parameters for interfacing Laboratory Instruments, Hospital Information System (HIS), Clinical Information System (CIS), Billing System, and separate program functions/servers using different protocol than the SoftLab® system, click the Open Interface Setup button.
![Check Communication with the Listening Program](image) | Check Communication with the Listening Program | To check on the running status of your instrument interface, click the Check Communication with the Listening Program button.
![Start Interface](image) | Start Interface | To start or restart the communication necessary for a particular interface, click the Start Interface button.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Stop Interface</td>
<td>To stop communication with an interface, click the Stop Interface button. A confirmation message will appear with the PID number that was stopped.</td>
</tr>
<tr>
<td>📯</td>
<td>Hide / Show Statistic Pane</td>
<td>To display instrument statistics (for example, Results posted results, rerun results, rejected results), click the Hide/Show Statistic Pane button. A window will appear on the lower left portion of the screen with the appropriate statistics.</td>
</tr>
<tr>
<td>✍️</td>
<td>Free-text Comments</td>
<td>To add a result comment to a test, click the Free-text Comments button. A window displays, allowing free-text comment entry, tag entry etc.</td>
</tr>
<tr>
<td>📦</td>
<td>Error Messages for Selected Records</td>
<td>To display the meaning of the entry in the Error field (for the test where the cursor is), click the Error Message button, or click View &gt; Error Message.</td>
</tr>
<tr>
<td>📊</td>
<td>Multiple Records Posting</td>
<td>To post multiple records, click the Multiple Records posting button.</td>
</tr>
<tr>
<td>🔍</td>
<td>QC Posting</td>
<td>To post QC results to SoftQC, click the QC Posting button.</td>
</tr>
<tr>
<td>📜</td>
<td>Specimen Comment</td>
<td>To add or view a specimen comment, click the Specimen Comment button to open the Result Comments window. You can enter a free-text comment or canned messages.</td>
</tr>
<tr>
<td>📜</td>
<td>Show Specimens</td>
<td>To display specimen details, click the Show Specimens button to open the Order-Specimen(s) window.</td>
</tr>
<tr>
<td>🔔</td>
<td>Canned Messages of the Selected Result</td>
<td>To enter a canned message of a result, click the Canned Messages of the Selected Result button. Select an appropriate canned message form the browser window.</td>
</tr>
<tr>
<td>📊</td>
<td>Display Diagnosis</td>
<td>To display the specimen’s diagnosis, click the Display Diagnosis button. The Diagnosis window displays.</td>
</tr>
</tbody>
</table>

**NOTE:** This document is Uncontrolled When Printed.

Any documents appearing in paper form that are not stamped in red "MASTER COPY" are not controlled and should be checked against the document (titled as above) on the server prior to use.
Printing Report( Results Report)

NOTE: Results must be verified first before printing.

KEYSTROKE  INSTRUCTIONS/RESULTS

1. Log on to SoftLab
2. Double Click on Results Report Icon if displayed  
3. or Click on Reports in Main menu,
4. Click Results Report or Press R Report Launcher Screen appears
   Defaults to Results Report Report Tag:
5. From Order: Scan or Enter Order number
6. To Order (Enter same as above)
7. Number of copies defaults to 1 change if needed
8. Results: ALL
9. Region: No entry
10. Print Click drop down to change to All
11. Patient type – Select appropriate type if known
12. Layout RL10, Format RR10 for all serology report except
13. Formats: For Transplant antibody- RR12,  
    For HBV DNA and HCV RNA Report Format: RR20
14. Req.Doctor: Enter if known
15. Phleb route ID : Leave Blank
16. Copies and Priorities don’t change unless needed
17. Select Appropriate Report Printer
18. Click Print to:
19. Flag as Reported? No Report Printed (1 copy)
To Fax Instant Report – Order Entry

NOTE: Results must be verified first or they will be resulted as in-lab

KEYSTROKE | INSTRUCTIONS/RESULTS
---|---
12. Log on to **SoftLab** | Search Order Window appears
13. Double Click **Order Entry** Icon | Order Screen window appears
14. In Order Entry field: Enter Order Number |  
15. Click **Next** |  
16. Click **Finish** |  
17. Click on **Printer** icon | Instant Report window appears
18. Click on **Instant Report or Press I** |  
21. All Chapters: **checked** |  
22. Number of copies: **1** (change if needed) |  
23. Click **Fax to** | Fax Browser Window appears
24. Select the appropriate fax number | Report Faxed (1 copy)
25. Click **OK** |  

Entering New Control Lot Number

**KEYSTROKE**

1. From SoftLab Main Menu
2. Click Tools then SoftQC
3. 4 Maintenance

**INSTRUCTIONS/RESULTS**

To Add new level

4. **A** Add new level: Create New Level window appears
5. **New level will be based on Lot#:** Enter old Lot # with N,P1,P2 or P3 at the end
6. Press **Enter**
7. **New Lot#:** Enter New Lot # with N,P1,P2 or P3 at the end
8. **Expiration date:** Enter expiration date ,F12,F12 ans ‘Y’
9. Repeat with each level

To Deactivate Old Lot#

10. **D** Deactivate Lot #
11. Enter old Lot #
12. **F12, F12**, and ‘Y’
13. Repeat with each level

To Activate New Lot#

14. **V actiVate Lot #**
15. Enter new Lot #
16. **F12, F12**, and ‘Y’
17. Repeat with each level
QC Entry

KEYSTROKE  
INSTRUCTIONS/RESULTS

QC Entry for one Order (Result Entry Screen)
(See Result Entry One Order)

1. The Results for QC entry box appears when the QC was not yet entered on that day
2. If not Click QC Current Result (+) or Press SHIFT and + at the same time Results for QC Window appears.
3. Click on QC result field and enter result
4. After all QC results are entered Click Close Automatically saves the entry.

QC Entry when Resulting by Tasklist (Tasklist Window)
(See Result Entry -Tasklist)

1. The Results for QC entry box appears when the QC was not yet entered on that day
2. If not open up Result Entry window for one order by pressing enter on highlighted order
3. Click QC Current Result (+) or Press SHIFT and + at the same time Results for QC Window appears
4. Click on QC result field and enter result
5. After all QC results are entered Click Close Automatically saves the entry.
6. Close the Result Entry Screen of the Order Brings you back to tasklist
Pending List Review for Architect and 8SERO Tests

**KEYSTROKE** | **INSTRUCTION/RESULTS**
---|---
1. Log onto the system | 
2. Click on **SoftLab tab** | Access to SoftLab
3. Go to **Resulting Worklist** | 
4. Select tests by **Template** | 
5. Type **ARCHI for Architect or 8SERO** for all **serology Orders** on **Template field** | 
6. Choose **Pend + Nonver** as **Status** | 
7. Space out **from order#** | 
8. Click **OK** | 
9. **Pending List** displays | 
10. Review List |
Send Out Workflow

1. Organize samples into worklist, TB Culture-New, Parasitology - New, Send Out List Worklist
2. Open worklist
3. Mark Orders
4. Use Macro appropriate for the worklist
5. Check at least One Order for accuracy
6. Unmark
7. Proceed to PRINTING FORMS

PRINTING PHL FORMS FOR TB AND PARA AND OTHER SENDOUT

(Use Paper with PHL Template)
1. Worklist should be still open
2. Click Mark
3. Scan Order
4. Highlight # the order by moving the cursor up
5. Click instant report
6. Select Printer (do only once)
6. Change Report Layout to MIC10 (needs to change every order)
7. Click OK

8. Click OK

8. Match Order and Sample
9. Attach Labels to form
10. Pack into PHL bags
Unmark
Mark
Highlight # moved cursor up
Click instant report
Click ok
NOTE: This document is Uncontrolled When Printed. Any documents appearing in paper form that are not stamped in red "MASTER COPY" are not controlled and should be checked against the document (titled as above) on the server prior to use.
Printing PHL Serology and HIV Forms

<table>
<thead>
<tr>
<th>KEYSTROKE</th>
<th>INSTRUCTIONS/RESULTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>26. Log on to <strong>SoftLab</strong></td>
<td></td>
</tr>
<tr>
<td>27. Click on <strong>Utilities</strong>, then double click <strong>Print Scheduler</strong></td>
<td>Report Launcher Screen appears</td>
</tr>
<tr>
<td>28. Click on + for yellow folder <strong>ALT RL10A REP</strong></td>
<td>Subfolders appears</td>
</tr>
<tr>
<td>29. Click on <strong>HIV FORM</strong> or <strong>PHL FORM</strong></td>
<td></td>
</tr>
<tr>
<td>30. Click on <strong>Setup Form</strong> tab</td>
<td></td>
</tr>
<tr>
<td>31. Scroll down to <strong>Order #</strong> field</td>
<td></td>
</tr>
<tr>
<td>32. Scan Order number</td>
<td></td>
</tr>
<tr>
<td>33. Click on <strong>Send To</strong> : Drop down</td>
<td>Select printer window appear</td>
</tr>
<tr>
<td>34. Select printer , Click <strong>OK</strong></td>
<td></td>
</tr>
<tr>
<td>35. Click <strong>Run</strong></td>
<td>PHL Form printed</td>
</tr>
</tbody>
</table>
Printing PHL Forms for TB and Parasitology and Other Sendout

SOFTMIC
(Use Paper with PHL Template)
1. Open Send Out Worklist
2. Click Mark
3. Scan Order
4. Highlight # the order by moving the cursor up
5. Click instant report
6. Select Printer (do only once)
6. Change Report Layout to MIC10 (needs to change every order)

7. Click OK
8. Click OK
Faster Way to Enter and Verify PHL Results

SOFTLAB

1. Double Click Resulting Worklist
   Template : 9SERO
   FOR ENTERING RESULTS    Status: Pending or All
   FOR VERIFYING RESULTS    Status: Nonverified
   Set range: From order # ________  To __________
   Received only
2. Click OK
3. Search by: Order : Enter LIS #
4. Click Find or Press ENTER
5. Check Patient Info

TO ENTER RESULTS
   a. Enter results using the keypad
   b. “?” Enter canned message and PHL #
   c. Save
   d. Enter next LIS # Step 3

TO VERIFYING RESULTS

NOTE: This document is Uncontrolled When Printed.
Any documents appearing in paper form that are not stamped in red “MASTER COPY” are not controlled and should be checked against the document (titled as above) on the server prior to use.

Management System\UHN_Mount Sinai Hospital Microbiology\Standard Operating Procedures\Bacteriology Procedures
a. Check Result and open message “\ “ to check canned message and PHL #
b. Click Verify to verify one, or verify all
c. Click Save Icon
d. Enter next LIS # Step 3
Reporting SoftMIC results though Call List

KEYSTROKE INSTRUCTIONS/RESULTS

1. Log on to SoftMic
2. Double click “Call List Request” Red telephone icon. Call List screen appears
3. Search criteria is defaulted to look back 2 days. Modify search criteria to last 14 days.
4. Click “Search” to find any pending calls Results screen appears
5. Expand “Micro Orders” by clicking on the + sign
6. Double click on a patient order to view information to call. Contact information will be displayed on the top right. The complete report is displayed on the bottom half of the screen.
   - Results to telephone will be documented in the “Person/Msg line” in the contact information screen.
   - The ward and phone number to call will be displayed here as well.
7. Once the call is made
   - Click the box beside “Called” in the Contact information section
   - Click in the Person/Msg field and document the result communicated, the person who took the result and that a readback was performed.
   - Save the order (click save icon)
8. For call placed on the list with no information, confirm with bench technologists the need for a phone call.
9. To cancel a call, mark the order as called and note in Person/Msg field “Call removed from list – No instructions noted”.
10. Save the order.

Documenting A Call

KEYSTROKE INSTRUCTIONS/RESULTS

1. Log on to SoftLab or SoftMic
2. Double click Lab Query Icon in SoftMic Results Query appears
   Lab Results Query Icon in SoftLab
3. Make sure Patient Demographic Pane is displayed in the screen
4. Query specimen by Lab Order number, MRN or other patient demographic.
5. Call Button can be accessed at Patient Demographic Pane only
6. If not Click on displays Patient Demographic Pane

6. Click Call Button Call Window appears

7. Once call is done click on Called box Green check mark appears
8. Click on Location Filed Drop Down to select Ward or Doctor
9. Click on Doctor ID field to select Doctor’s ID
10. Phone Number and Extension number will populate automatically, to change highlight the number, press delete key and enter new number.
11. Enter Contact person information and other relevant information in Person/Msg field.
12. To check Call History, Click on History Button
13. Click OK to exit Call Window.
SoftStore

Logging On Procedure to SoftLabMicStore

Set Caps Lock off, use **lower case** only for log in.

<table>
<thead>
<tr>
<th>KEYSOTKE</th>
<th>INSTRUCTIONS/RESULTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click on <strong>SoftLabMic</strong> icon on desktop</td>
<td>The Login window appears.</td>
</tr>
<tr>
<td>2. Enter <strong>user id</strong></td>
<td></td>
</tr>
<tr>
<td>3. Press <strong>tab</strong></td>
<td></td>
</tr>
<tr>
<td>4. Enter <strong>password</strong></td>
<td></td>
</tr>
<tr>
<td>5. Click <strong>OK</strong></td>
<td>A main menu appears.</td>
</tr>
<tr>
<td>6. If not in the correct module, click the appropriate tab at the bottom right.</td>
<td></td>
</tr>
<tr>
<td><strong>SoftLab</strong></td>
<td>The correct main menu appears.</td>
</tr>
<tr>
<td><strong>SoftMic</strong></td>
<td></td>
</tr>
<tr>
<td><strong>SoftStore</strong></td>
<td></td>
</tr>
</tbody>
</table>
## Add a New Specimen Vial to the Freezer

**Note:** To freeze (store) a vial of a specimen without any isolate.

<table>
<thead>
<tr>
<th><strong>KeyStroke</strong></th>
<th><strong>Instructions/Results</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click on <strong>Store Vial</strong> icon</td>
<td>Store vial screen appears</td>
</tr>
<tr>
<td>2. Click on <strong>Search Lab</strong> icon</td>
<td>Microbiology search screen appears. Curser is on the order number window.</td>
</tr>
<tr>
<td>3. Type lab number or barcode</td>
<td></td>
</tr>
<tr>
<td>4. Click the <strong>Next</strong> button</td>
<td>Search results screen appears with order.</td>
</tr>
<tr>
<td>5. Click <strong>OK</strong> button</td>
<td>Information populates screen.</td>
</tr>
</tbody>
</table>

**Note:** If more than one test/specimen

1. Hold the **Shift** key down and click on the second test. Click **OK** button. Information populates screen

2. **<F8>** To bring you to test ID for first test/specimen.

3. **<F9>** To bring you to the INV study for first test.

4. **<F2>** or click **Drop down arrow** Shows list of studies

5. Page up or down or **<□ ↓>** Move curser to the correct study and press Enter.

6. **<Ctrl A>** or click **Auto assign location** To assign location

7. Click the **Save** icon or **<Ctrl S>** if only one test/specimen

8. Click **Yes** button To print labels.
Continue from step 14 if storing one test/specimen.

If there are multiple tests/specimens to freeze:

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Instructions/Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>a) Click on the next test/specimen</td>
<td></td>
</tr>
<tr>
<td>b) (&lt;F9&gt;)</td>
<td>To bring you to the INV study</td>
</tr>
<tr>
<td>c) (&lt;Ctrl A&gt;) or click Auto assign location</td>
<td>To assign location</td>
</tr>
<tr>
<td>d) Click the <strong>Save</strong> icon or (&lt;Ctrl S&gt;)</td>
<td>To save</td>
</tr>
<tr>
<td>e) Click <strong>Yes</strong> button</td>
<td>To print labels.</td>
</tr>
<tr>
<td>g) (&lt;F2&gt;) or click <strong>Drop down arrow</strong></td>
<td>Shows list of studies</td>
</tr>
<tr>
<td>h) Page up or down or (&lt;\uparrow&gt;)</td>
<td>Move curser to the correct study and press Enter</td>
</tr>
<tr>
<td>i) (&lt;Ctrl A&gt;) or click <strong>Auto assign location</strong></td>
<td>To assign location</td>
</tr>
<tr>
<td>j) Click on the <strong>Save</strong> icon or (&lt;Ctrl S&gt;)</td>
<td></td>
</tr>
<tr>
<td>k) Click <strong>Yes</strong> button</td>
<td>To print labels.</td>
</tr>
</tbody>
</table>

14. Choose the printer in the Print labels screen.

15. Click the **OK** button. Labels print.

16. Click the **X** in the top right corner Exits Store vial.
Add a New Isolate Vial to the Freezer

Note: Do not freeze (store) until isolates have complete ID and sensitivity. If the information is incomplete when the isolate is stored, click the UM (update mic) icon under Edit in Store vial.

KeyStroke | Instructions/Results
---|---
1. Click on **Store Vial** icon | Store vial screen appears
2. Click on **Search Mic** icon | Microbiology search screen appears. Cursor is on the order number window.
3. Type lab number or barcode | 
4. Click the **Next** button | Search results screen appears with order.
5. Click **OK** button | Information populates screen.

Note: If more than one isolate

6. Hold the **Shift** key down and click on the second isolate. Click **OK** button. | Information populates screen

7. <F8> | To bring you to test ID for first organism.
8. <F9> | To bring you to the INV study for first organism.
9 **F2** or click **Drop down arrow** | Shows list of studies
10. Page up or down or <□ ▼> | Move cursor to the correct study and press Enter.
11. **Ctrl A** or click **Auto assign location** | To assign location
12. Click the **Save** icon or **Ctrl S** if only one isolate | 
13. Click **Yes** button | To print labels.
Continue from step 14 if storing one isolate or one vial of the specimen.

If there are multiple isolates to freeze:

Keystroke | Instructions/Results
---|---
f) Click on the next isolate

g) \(<F9>\) | To bring you to the INV study

h) \(<Ctrl A>\) or click Auto assign location | To assign location

i) Click the Save icon or \(<Ctrl S>\) | To save

j) Click Yes button | To print labels.

g) \(<F2>\) or click Drop down arrow | Shows list of studies

h) Page up or down or \(<\downarrow>\) | Move cursor to the correct study and press Enter

i) \(<Ctrl A>\) or click Auto assign location | To assign location

j) Click on the Save icon or \(<Ctrl S>\)

k) Click Yes button | To print labels.

14. Choose the printer in the Print labels screen.

15. Click the OK button. | Labels print.

16. Click the X in the top right corner | Exits Store vial.
Reprint Labels

To reprint a label for a vial that has been entered into SoftStore previously

<table>
<thead>
<tr>
<th>KEYSTROKE</th>
<th>INSTRUCTIONS/RESULTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click on SoftStore</td>
<td>Main menu appears</td>
</tr>
<tr>
<td>2 Click on Store vial</td>
<td>Store vial screen appears</td>
</tr>
<tr>
<td>3. Click on Switch to</td>
<td>Search screen appears.</td>
</tr>
<tr>
<td>Edit/Read mode icon</td>
<td></td>
</tr>
<tr>
<td>4. &lt;F3&gt;</td>
<td>Cursor goes to order number field</td>
</tr>
<tr>
<td>5. Enter or barcode in</td>
<td>Order appears on screen</td>
</tr>
<tr>
<td>order number</td>
<td></td>
</tr>
<tr>
<td>6. Press Enter twice</td>
<td></td>
</tr>
<tr>
<td>7. Click on the Print</td>
<td>Choose the appropriate option – either print labels for current test or print labels for all tests.</td>
</tr>
<tr>
<td>labels icon</td>
<td></td>
</tr>
<tr>
<td>8. Choose the printer</td>
<td></td>
</tr>
<tr>
<td>in the print labels</td>
<td></td>
</tr>
<tr>
<td>screen</td>
<td></td>
</tr>
<tr>
<td>9. Choose the number</td>
<td></td>
</tr>
<tr>
<td>of labels to print</td>
<td></td>
</tr>
<tr>
<td>10. Click OK button</td>
<td></td>
</tr>
</tbody>
</table>

Click X in top right corner to exit Store vial.
## Record of Edited Revisions

**Manual Section Name:** Laboratory Information Systems Bench Procedure Manual

<table>
<thead>
<tr>
<th>Page Number / Item</th>
<th>Date of Revision</th>
<th>Signature of Approval</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annual Review</td>
<td>March 16, 2002</td>
<td>Dr. T. Mazzulli</td>
</tr>
<tr>
<td>Annual Review</td>
<td>March 30, 2003</td>
<td>Dr. T. Mazzulli</td>
</tr>
<tr>
<td>Annual Review</td>
<td>May 26, 2004</td>
<td>Dr. T. Mazzulli</td>
</tr>
<tr>
<td>Annual Review</td>
<td>May 10, 2005</td>
<td>Dr. T. Mazzulli</td>
</tr>
<tr>
<td>Annual Review</td>
<td>July 12, 2006</td>
<td>Dr. T. Mazzulli</td>
</tr>
<tr>
<td>Annual Review</td>
<td>August 13, 2007</td>
<td>Dr. T. Mazzulli</td>
</tr>
<tr>
<td>Revised the name Ulticare to Mysis-EPR throughout manual</td>
<td>November 4, 2008</td>
<td>Dr. T. Mazzulli</td>
</tr>
<tr>
<td>Annual Review</td>
<td>November 4, 2008</td>
<td>Dr. T. Mazzulli</td>
</tr>
<tr>
<td>Annual Review</td>
<td>March 30, 2009</td>
<td>Dr. T. Mazzulli</td>
</tr>
<tr>
<td>Annual Review</td>
<td>March 22, 2010</td>
<td>Dr. T. Mazzulli</td>
</tr>
<tr>
<td>Removed AxSym Interface Startup</td>
<td>June 28, 2010</td>
<td>Dr. T. Mazzulli</td>
</tr>
<tr>
<td>Annual Review</td>
<td>December 05, 2011</td>
<td>Dr. T. Mazzulli</td>
</tr>
<tr>
<td>Annual Review</td>
<td>May 31, 2012</td>
<td>Dr. T. Mazzulli</td>
</tr>
<tr>
<td>Annual Review</td>
<td>May 31, 2013</td>
<td>Dr. T. Mazzulli</td>
</tr>
<tr>
<td>Updated UHN/MSH logo Bridgepoint MRN change to HI############</td>
<td>October 1, 2014</td>
<td>Dr. T. Mazzulli</td>
</tr>
<tr>
<td>Annual Review</td>
<td>October 1, 2015</td>
<td>Dr. T. Mazzulli</td>
</tr>
<tr>
<td>Annual Review</td>
<td>October 1, 2016</td>
<td>Dr. T. Mazzulli</td>
</tr>
<tr>
<td>Annual Review</td>
<td>October 1, 2017</td>
<td>Dr. T. Mazzulli</td>
</tr>
<tr>
<td>Instructions added for Reporting calls using Call List</td>
<td>January 8, 2018</td>
<td>Dr. T. Mazzulli</td>
</tr>
<tr>
<td>Quality Manual</td>
<td>Policy # MI_LIS</td>
<td>Page</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------</td>
<td>------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>171 of 171</td>
</tr>
</tbody>
</table>

| Section: Bacteriology Procedures | Subject Title: Laboratory Information Systems Bench Procedure Manual |

NOTE: This document is Uncontrolled When Printed. Any documents appearing in paper form that are not stamped in red "MASTER COPY" are not controlled and should be checked against the document (titled as above) on the server prior to use.